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Uvodna re�

BROJ PO BROJ,  STIGLI SMO I DO DESETOG IZDANJA  NAŠEG I

VAŠEG OMILJENOG ASOPISA� . MALI  JUBILEJ EMO�  ISKORITITI

KAO  PRIPERMU ZA  PROSLAVU IZLASKA  DVANAESTOG  BROJA,
KOJI E�  OBELEŽITI PRVU GODINU  POSTOJANJA GNU ZILLE .

Deseti broj donosi nekoliko vrlo zanimljivih tema. Pr imili smo nekoliko
emailova italaca koji su izrazili želju da vide tekstove posve ene dže� � -
pnim ra unarima, pa smo od ovog broja krenuli u pri u p rikazom distri� � -
bucije namenjene baš takvoj vrsti ra unara. Sve ve i broj korisnika distri� � -

bucija baziranih na Debianu je istakla potrebu objašnjavanja procesa ma-
nipulacije paketima karakteristi nim za ovakve distribucije , pa e svi ita� � � -
oci koji do sada nisu znali kako da instaliraju pakete na  svom sistemu, u
GNUzilli 10 prona i upustvo koje e im biti od pomo i. Slobodna komu� � � -
nikacija bi trebalo da bude imperativ svakog društva sves nog zna aja slo� -

boda pojedinaca, pa se u ovom broju doti emo Jabbera, najkvalitetnijeg�

NAGRADNA IGRA

Pošaljite na našu adresu kontakt

email, podatke i odgovor na pita-
nje:

Kako se zove predstavnik
Fondacije za slobodan

softver Evrope, koji je u
aprilu posetio Beograd?

Šest najvernijih italaca o ekuju� �

vredne nagrade.

NAPOMENA:

Iz tehni kih razloga, nismo u mo� -
gu nosti da nagradnu igru reali� -

zujemo van teritorije Srbije.
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Distribucije

NAKON  ODSTRANJIVANJA  OKRUŽENJA  GNOME, DISTRIBUCIJA SLACKWARE

JE IZGUBILA  DOSTA KORISNIKA . TAKVA  POJAVA JE DONEKLE  I LOGI AN�  SPLET

DOGA AJA� ,  JER JE KORISNI KA�  POPULACIJA OVE DISTRIBUCIJE MAHOM

NAPREDNIJEG NIVOA  ZNANJA  I ZA  NJU SE VEZUJE STEREOTIP KORIŠ ENJA�

GNOME OKRUŽENJA . POKAZALO  SE DA  JE DOBAR BROJ KORISNIKA  ZAISTA

PROMENIO  DISTRIBUCIJU,  DOK SU SE VERNI PRATIOCI SLACKWAREA

PRILAGODILI  NOVONASTALOJ  SITUACIJI.  U  SVAKOM  SLU AJU� ,  SLACKWARE

NASTAVLJA  SVOJIM PUTEM I POJAVLJUJU SE U NOVOJ VERZIJI SA OZNAKOM

10.2.

Slackware je ranije bio poznat po tome da se distribuira na je-
dnom CD-u, no to se promenilo. Slackware 10.2 se isporu uje na 4�
diska koji donose puno zanimljivih paketa koji mogu bit i potrebni u
svakodnevnom radu. Prva dva diska su instalacioni medi ji na ko-
jima se nalazi osnovni set paketa potrebnih za instala-

ciju sistema. Druga dva diska sadrže extra pakete
i izvorni kod softvera. Pored softvera, na disko-
vima se može na i dokumentacija kao i zip� -
slack, koji se nalazi na etvrtom disku. Ova� -

kav raspored sadržaja je veoma zanimljiv, jer
su diskovi vrlo dobro iskoriš eni. Ipak tu je�
moglo  biti  mesta  za  Openoffice,  na  primer,
koga nema na diskovima. Extra paketi obuhva-
taju  programe koji  su  potrebni  ve ini  korisnika,�

poput alata za narezivanje diskova (K3B i XCDRoast),
Jave ili GRUB boot loadera.

10.2 na stolu
Instalacija ovog izdanja ne razlikuje se puno od prethodnih, pa se

ne emo mnogo zadržavati na ovom segmentu pri e. Po ko zna koji� �
put emo ponoviti važnost pažljivog odabira particija i par ticionisa� -
nja diska, ukoliko particije nisu spremne, kako bi se izbegla mogu-
nost gubljenja podataka na disku. Ostatak posla je, manje više, ru� -

tiski, pri emu preporu ujemo automatsku instalaciju svih  paketa,� �

za šta je potrebno nešto više od tri gigabajta prostora na disku.
Podrazumevani kernel na sistemu je verzije 2.4.31 verzija, ime�

Slackware nastavlja trend koriš enja provereno stabilne i dovoljno�
istestirane 2.4 serije Linuxa.  Ovo je donekle razumljivo,  ali  treba
imati na umu da je serija 2.6 ve  uveliko stabilna i pouzdana. Na� -

ravno,  postoji  opcija  ijim odabirom se instalira  kerne l  u  verziji�
2.6.13, što se preporu uje korisnicima koji imaju noviji  hardver po� -
put sistema sa SATA kontrolerima koji ne e raditi na 2.4 kernelima.�
Za pohvalu je injenica da se na diskovima mogu na i izvor ni kod i� �

hederi za ove verzije kernela, što omogu ava kompajliranje drajve� -
ra za softverske modeme i grafi ke kartice, a od velike je važnosti�

za korisnike.
Kao i obi no, mnogo toga je potreb� -

no  podesiti  nakon  instalacije,  da  bi
Slackware bio doveden u optimalno
stanje. Nakon logovanja na sistem u

konzolnom režimu, potrebno je u ini� -
ti  nekoliko zahvata na konfiguracio-
nom fajlu X servera kako bi grafika
dobro radila. Ukoliko postoji potreba
za  logovanjem u  grafi kom režimu,�

broj 3 treba zameniti brojem 4, u sle-
de em redu fajla /etc/inittab�
id:4:initdefault:

 Na test ra unaru je bilo problema�
sa monitorom, iako se radi o monito-

ru koji pokriva širok opseg frekvenci-
ja osvežavanja, pa je prvi korak ka

dobijanju funkcionalnog okruže-
nja bilo podešavanje osvežava-
nja  monitora.  Treba  pogledati

da li postoji drajver koji podrža-
va  grafi ku karticu na  sistemu,�

jer  se  po  podrazumevanim
podešavanjima koristi  vesa drajver.

Nakon ovih korekcija, X server je pro-
radio i na radnoj površini se ukazalo
grafi ko okruženje KDE, koje je pod� -
razumevano i jedino složeno grafi ko�
okruženje  na sistemu. Ipak,  podeša-

vanja X servera se ovde ne završava-
ju, jer je za rad scroll to ki a potrebno� �
imati  slede e  redove  u  fajlu  /�
etc/X11/xorg.conf
Option "Protocol"    "IMPS/2"

Option "ZAxisMapping"    "4 5"

Tek  nakon  unosa  ovih  redova  u
konfiguracioni fajl, scroll to ki  e ra� � � -
diti kako valja.

Sam KDE dolazi u verziji  3.4.2,  sa

svim aplikacijama koje su karakteri-
skti ne za ovo okruženje. Pored KDE-�
a,  mogu e  je  koristiti  i  XFCE 4.2.2,�
koje  se  sve  više  približava  vode oj�
dvojci takozvanih "velikih" grafi kih�

okruženja. XFCE pokazuje prisustvo i
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podršku za aplikacije bazirane na GTK bibliotekama. Sve bitnije sfe-
re ra unarskog života su pokrivene programima karakteri sti nim� �

za KDE, sa nekoliko izleta ka aplikacijama koje jednostavno moraju
biti prisutne.

Slackware 10.2 je veoma dobro multimedijalno potkovan, pa je za
slušanje muzike nadležan KDE-ov pulen Juk, dok je video playback
prepušten ve  proverenom rešenju u  vidu XINE media  p layera.�

Može se koristiti i GTK frontend XINE-a - GXINE. Bit no je napome-
nuti to da sistem nije konfigurisao DVD ure aj na test  ra unaru, pa� �
je gledanje dvd filma bilo mogu e tek nakon intervenc ija u fajlu /�
etc/fstab. Ostatak poslova koji  se ti u slušanja i  kop iranja audio�

diskova, snimanja zvuka ili manipulacije ja inom zvuka s e obavlja�
alatima iz okruženja KDE koji posao rade više nego dobro.

Ve  pomenuti nedostatak OpenOffice paketa se može navesti kao�
prvi ve i minus ovog izdanja, za ije poslove je namenjen paket Ko� � -
ffice, koji u svom okviru poseduje sve alate koji mog u biti potrebni

za kancelarijski rad. Naravno, program za rad sa bazama podataka
koji  postoji  u paketu OpenOffice 2,  u Kofficeu ne po stoji.  Drugi
minus ove verzije je nepostojanje valjanog alata za rad sa vektor-
skom grafikom, dok je druga sfera obrade grafike opskrbljena lo-
gi nim izborom u vidu GIMP-a. Svakako, moglo je da se na e me� � -

sto paketu sa nekim programom za manipulaciju vektorskom grafi-
kom na na nekom od diskova.

Izbor  internet  softvera  ima  smisla.  Ve ina  aspekata  koriš enja� �

interneta  pokriveno  je  sa  bar  dve
aplikacije. Pregled web strana je mo-

gu e  initi  podrazumevanim  KDE-� �
ovim browserom Konqueror,  dok je
familija Mozilla prisutna sa oba svoja
lana.  Firefox  je  prisutan  u  verziji�

1.0.6, a Mozilla Suite (u punom sasta-

vu)  u  verziji  1.7.11.  Za  itanje  ele� -
ktronske pošte zaduženi su Kmail ili
Mozilla  Thunderbird,  dok je  instant
poruke mogu e razmenjivati pomo i� �

Gaima ili Kopetea. Jedini grafi ki alat�
za povezivanje na internet je KPPP, a
preuzimanje fajlova sa interneta mo-
gu e je vršiti  pomo u Kgeta, dok se� �
kao  IRC  klijenti  pojavljuju  XChat  i

KSirc.
Sistem se tokom testiranja pokazao

izuzetno stabilnim, u šta se nije ni su-
mnjalo. KDE je radio kako treba, dok
je sitnijih problema bilo sa Kofficeo-

vim alatom za obradu slika. No, pita-
nje  je  ko  e  pored  GIMP-a  koristiti�
ovaj alat. Instalacija drajvera za soft-
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verski modem i nVidijinu grafi ku karticu je protekla b ez problema,�
pa je potencijalno problemati an hardver proradio bez pro blema.�

Treba pomenuti  podršku za naš jezik  koji  omogu ava kor iš enje� �
KDE-a na srpskim. Paketi koje treba instalirati, kako bi se dobilo
okruženje na srpskom, nalaze se na drugom disku.

Slackware je oduvek bio distribucija koju su koristili  oni koji znaju

malo više o instalaciji i podešavanju sistema. Problemi koje ve ina�
distribucija rešava na vrlo elegantan na in, na Slackwareu još uvek�
postoje. ak i distribucije koje su nekada važile za "teške", kao što je�
Debian, mnoge poslove obavljaju automatski, što sa Slackwareom

nije slu aj. Jednostavno, neki problemi mogu biti toli ko banalni da�
je dosadno rešavati ih iz verzije u verziju. U svakom slu aju, insta� -
lacijom Slackwarea se dobija vrlo stabilan i pouzdan sistem, što je
ovu distribuciju i rangiralo tamo gde jeste. Nedostatak  GNOME-a
je, po mišljenju autora teksta, ogroman nedostatak kojim je Slack-

ware puno izgubio,  no  kvalitet  ovog izdanja  pokazuje  da  je  za
Slackwareov tim GNOME jedna briga manje, pa ostavljamo kor isni-
cima da prosude da li je GNOME trebalo izostaviti ili ne.

Korisna adresa:
http://www.slackware.com

~Ivan Jeli�
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Hardver

PRELISTAVAJU I�  CENTRALNOEVROPSKE FORUME POSVE ENE�  OPENSOURCE

SOFTVERU ZAINTRIGIRAO  ME JE JEDAN SPECIFI AN�  POST. JEDNOG N IJEMCA

ZANIMALO  JE KOJE MINIMALNE  USLOVE MORA  ISPUNITI  POCKET PC DA  BI

POGONIO  LINUX  I UJEDNO KOJI JE NAJJEFTINIJI MODEL  KOJI SI POSEBNO ZA

OVU  SVRHU MOŽE  KUPITI . UBRZO SAM UVIDIO  SAM DA  ON NIJE JEDINI –
NEKOLIKO  SRODNIH  TEMA  PRONAŠAO SAM NA  SLI NIM�  OKUPLJALIŠTIMA

*NIX  EUNTUZIJASTA .  SVE NJIH NIJE ZANIMALA  POSLOVNA  PRIMJENA U

POSLJEDNJE VRIJEME SVE MO NIJE�  I PRISTUPA NIJE�  ( ITAJ� :  JEFTINIJE)
POCKET PC PLATFORME, VE�  ISKLJU IVO�  POKRETANJE ŠIROKOG SPEKTRA

LINUX  APLIKACIJA  NA  DLANOVNICIMA .  U  GLAVI  SAM VE�  IMAO

PREDSTAVU:  OPERACIJA “P INGVIN  NA  IPAQ-U”  MORA  SE PROVESTI

ODMAH .

Izvrsni sajt http://www.handhelds.org polazna je ta ka z a ovu�
tematiku. Izuzetno jaka komu-
na kojoj je ovaj sajt baza rado

e  pružiti  informacije  o  svim�
fazama  tranzicije  dlanovnika
na pingvinoliki  OS.   Projekat
Familiar od 2001. godine razvi-
ja  relativno  mala  grupa  pro-

gramera,  pokušavaju i  da  iz� -
gradi  stabilnu,  potpuno funk-
cionalnu  Linux  distribuciju  i
niz  upotrebljivih  aplikacija  za
ru ne ra unare bazirane na Po� � -

cket  PC  hardveru.  Radi  se  o
zrelom proizvodu, uglavnom orijentisanom na Heweltt-Pac kard
iPAQ seriju (h3100, h3600, h3700, h3800, h3900, h5400, h5500). To
ne  zna i  da   (ne) e  funkcionisati  na  modelima  drugih  pro� � -
izvo a a,  ali  je  za  njih  bolje  prona i� � �

posebno prilago enu distribuciju ili kom� -
pajlirati  posebnu varijantu kernela  (pri-
mjer LOOX Linuxa). U trenutku pisanja
lanka aktuelna  verzija  Familiara,  0.8.2,�

nudi  izbor  izme u  dva  korisni ka� �
okruženja GPE i Opie (obe sa li nim or� -
ganizatorom i dodatnim aplikacijama) sa
podrškom za ipkg paketni menadžment,
implementaciju  sistemskih programa na

busyboxu (ušteda memorije) i  Dropbear
SSH server. Dosta uvoda: pred vama su
iskustva koja sam imao sa instalacijom i
prvim  utiscima  Familiar  distribucije  na

IPAQ h3630 dlanovniku  proizvedenom
1999. godine

Na startu upozorenje za neiskusne en-
tuzijaste – itav niz koraka instalacije je� -
dnostavno nije mogu e poništiti i vratiti�
se unazad. Zato oprez, da ne biste umje-
sto Linuxa dobili poptuno neupotrebljiv

dlanovnik! Tako e, ne bi bilo loše da na�
adresi [1] provjerite listu kompatibilnog
hardvera da vam recimo, GPRS CF kar-
tica koju ste „masno“ platili  ne bi bila
neupotrebljiva  na  novom operativnom

sistemu.  U  drugom  koraku  pobrinuo
sam se da preko serijskog kabla sinhro-

nizujem  organizator
h3630 sa mojim stonim

ra unarom i  sa uvam� �
sve  podatke  iz  Flash
RAM-a koje sam sma-
trao  bitnim.  Isti  ra u� -
nar i kabl sam upotri-

jebio  za  proceduru
instalacije. Moram na-
glasiti  da  mi je stalna
Internet  veza “u  real-
nom  vremenu”  i  pri-

stup  pomenutom  ha-
ndhelds.org  sajtu  pomogla  da
prevazi em neke probleme na koje sam�
naišao, pa vam je tokom ove polusatne
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Instalacija Linuxa na IPAQ
Puni Linux sa mainstream kernelom se može pokrenuti i na Pocket PC dlanovniku. Slijede detaljna
uputstva za instalaciju distribucije Familiar, te iskustva i savjeti iz prve ruke.



Hardver

procedure toplo preporu ujem. Sve�
vrijeme instalacije Pocket PC bi tre-

balo da bude povezan na struju, da
se baterija ne bi ispraznila, a onda...
znate ve . �

Detaljne  instrukcije  pod  [2]  e  se�
pobrinuti  da  instalacija  pro e  bez�

ve ih nedoumica.  Kod preuzimanja�
instalacionih datoteka neophodno je
izabrati  stabilnu  ili  release  verziju,
željeni model Pocket PC-a za koji je

OS prilago en, te jedan od 3 paketa�
aplikacija.  Ponu eni su GPE (GTK-�
bazirani  grafi ki  interfejs)  i  Opie�
(baziran na Qtopia-i) za “normalne”
korisnike, te bootstrap komandna li-

nija  za  programere.  Nakon  preuzi-
manja 14MB velike tar.gz arhive, ne bi bilo loše da provjerite njen
MD-checksum kako vas u kasnijem toku ne bi do ekala neprija� -
tna iznena enja. Moj izbor je bila stabilna verzija i Opie okruže� -
nje (ne pitajte zašto :).

Sljede i korak u kojem ete sa Interneta preuzete datoteke kopi� � -
rati na Pocket PC, može se obaviti na nekoliko na ina: ja sam se�
odlu io za korištenje SynCE softvera pod Linuxom (kon figurisa� -
nog za vezu preko ttyS0) za kopiranje bootloadera na dlanovnik.
On se sastoji od dvije datoteke: programa "BootBlaster" ija je za� -

da a da prepiše boot sektor u flash memoriji dlanovni ka sa boo� -
tloaderom "bootldr" koji može da ini-
cijalizuje i Windows Mobile (WinCE)
i  Linux.  Zatim  na  dlanovniku  po-
tražite navedenu izvršnu datoteku i

pokrenite  je.  Poziv  opcija  Flash  >
Save Bootldr.gz i Save Wince.gz for-
mat snimi e trenutni bootloader i sli� -
ku trenutnog stanja operativnog sis-

tema   dlanovnika,  nakon  ega  je�
možete  prebaciti  na  neku memorij-
sku karticu ili hard-disk. Ovaj korak
možete  presko iti  SAMO  ako  vas�
povratak na MS WinCE (Mobile) ili

recimo Sharpov  Zaurus  ne zanima.
Ra unajte da e transfer trajati dese� � -
tak ili više minuta. 

Zatim pozovite opciju Flash > Program i tokom ovih 15 s ekundi
ne dirajte vanjsku dugmad za reset ili paljenje dlanov nika, ina e�

e ostati u neupotrebljivom stanju. Ako je korak prote kao u naj� -
boljem redu, Flash > Verify e to potvrditi; u suprot nom pokušaj� -
te flashovanje ponovo ili  programirajte svoj flash sa sa uvanim�
WinCE bootloaderom. Tako e, autori Familiara savjetuju da  ih�
kontaktirate ako i dalje ne budete imali sre e i da dlanovnik ne�

gasite ili  resetujete.  No, testirani h3630

je  isprva  prihvatio bootloader,  pa sam
prešao na sljede i korak – reset.�

Nakon  kratkotrajnog  gašenja  ekrana
eka e vas vjerovatno prvi pingvin ko� � -

jeg ete ugledati  na Ipaqu. Na stonom�

ra unaru  pokrenite  terminal  (minicom�
ili  kermit),  unesite  “115200 8N1  serial
configuration,  no  flow  control,  no
hardware handshaking” kao parametre

i  pritisnite  dugme  sa  ikonicom

kalendara  (krajnje  lijevo).  Kada
dobijete  boot> prompt zna i  da�
ste na pravom putu i da bootloa-
der  o ekuje  da  mu  (koriste i� �
ymodem) pošaljete preostalu da-

toteku sa ekstenzijom jffs2 sa sto-
nog  ra unara.  Ta  procedura  e� �
trajati  dvadesetak minuta nakon
ega bi proces trebalo da po ne� �

sa  erasing  sector  00140000  i
završiti sa verifying ... formatting
...  done.  Kada ponovo ugledate
prompt, od pune Linux funkcio-
nalnosti na dlanovniku vas dijeli

samo zadavanje  komande  boot.
Moram napomenuti da sam ovaj  kom-
pletan korak (bezuspješno) pokušao na
drugom ra unaru pod Windowsom XP�
SP2 sa Hyperterminal i Mtty klijentima,

pa ih u ovu svrhu ne savjetujem. Prije
nego što vas prsti i dlan zabole od tip-
kanja po ekranu, još vam preostaje da
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promjenite  root  lozinku  (predefinisana  je  prazna),  te  d a  se
povežete na Internet, pozovete sinhronizaciju vremena (ntpdate
-b time.handhelds.org) i  preuzimanje svježe liste paketa  i  osv-
ježenje samog package managera (ipkg update/upgrade).

U osnovnom paketu do eka e vas standardna konzola i konzol� � -
ne aplikacije, softver za organizaciju (DrawPad, TextEditor, Con-
tacts,  Calendar,  Today,  ToDo),  file  manager  (fm)  i  spomenuti
package manager (ipkg), te alat za automatsku sinhronizaciju i

backup unesenih podataka. Na kraju napomena da Familiar ni je
osaka ena  verzija  Linuxa –  baziran  je  na  mainstream kernelu�
2.4.x. To opet zna i da se sve aplikacije mogu direktno portovati�
na iPAQ bez potreba za ponovnim pisanjem koda (osim ako veli-

ina ekrana ili ograni enje memorije predstavlja problem).  � �
Oni koji se ve  vide kao developeri za ovu verziju Linu xa, po� -

zvani su da se pridruže, bilo u radu na Familiaru ili na p rogrami-
ma [3]. Znatiželjni e nakon posjete handhelds.org sajtu primjetiti�

i  Intimate  distribuciju,  pa

emo je i ovdje kratko spo� -
menuti.  Intimate  je  puna
Linux distribucija za Com-
paq Pocket PC-e bazirana
na  Debianu.  Nastala  je

spajanjem aktuelne verzije
Familiara  i  hiljada  posto-
je ih debianovih ARM pa� -
keta. No, za korištenje ove
verzije zaboravite na Flash

memoriju  i  prona ite�
medij  na koji  e stati  140�
MB,  koliko  je  težak  Inti-
mate. Iako bi se itavo iz� -
danje  Gnuzille  moglo

posvetiti  samo  ovoj  tematici  vrijeme  je  za  ta ku.  Aplau z�
dobrodošlice za pingvine koji su se „dogegali“ na naš dlan , pa se
zaputite na Familiarov Wiki [4] i FAQ [5].

Korisne adrese:
[1]  http://www.handhelds.org/moin/moi-
n.cgi/IpaqHardwareCompatibility  i
http://familiar.handhelds.org/releases/v0.
8.2/install/prerequisites.html
[2]
http://familiar.handhelds.org/releases/v0.
8.2/install/
[3]  http://www.handhelds.org/moin/moi-
n.cgi/DeveloperDocuments
[4]  http://www.handhelds.org/moin/moi-
n.cgi/FrontPage
[5]  http://www.handhelds.org/handhelds-
faq/handhelds-faq.html

~ Borislav Tadi�
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NAKON  PODOSTA NOVINA  KOJE NAM  JE DONEO  GNOME
2.10,  MOGLO  SE O EKIVATI�  DA  E�  POLA  GODINE  KASNIJE

SPISAK NOVOTARIJA  BITI KRA I� .  2.12  NASTAVLJA  SA

POBOLJŠANJIMA,  DONOSE I�  NEKOLICINU  PROMENA  KOJE E�

NAM  OLAKŠATI  ŽIVOT  U NAREDNIH  ŠEST MESECI.

Po svemu sude i, dužina liste sa novinama nije bila�

imprativ programera GNOME-a kada je u pitanju iz-
danje 2.12. Nekoliko poboljšanja e zaista pružiti još�
lagodniji rad nego što je to slu aj sa prethodnim ver� -
zijama, kako obi nim korisnicima, tako i admistrato� -

rima.  Ve  smo navikli  da  se svako novi  GNOME�
odlikuje  pove anom  stabilnoš u  i  brzinom,  što  je� �
slu aj i sa verzijom 2.12. GNOME je još brži, stabilni� -
ji i lepši nego ranije.

Radno okruženje
Prvi  pogled  na  radnu  površinu  nove  verzije  ne

ukazuje ni na šta novo. No, prva aktivnost na radnoj
površini  e  pokazati  i�
prvu  novinu.  GNOME

sada ima novu podrazu-
mevanu  temu,  koja  svo-
jim  kvalitetom  ve  duže�
vreme skre e pažnju, dok�
je neke distribucije odav-

no  koriste  kao  podrazu-
mevanu na ovom okruženju. U pitanju je tema Cle-
arlooks, koja je unapre ena i sada ostavlje veoma lep�
utisak  na  korisnika,  pokazuju i  da  GNOME  nije�
ružno pa e kakvim ga mnogi korisnici smatraju. Sle� -

de i korak bi mogle biti ikonice pošto je trenutni se t�
prisutan  ve  duži  niz  verzija.  GNOME  je  pored�
estetske intervencije dobio i nekoliko zanimljivih op -
cija kada je podrazumevani fajl menadžer u pitanju.

Sada je mogu e prevu i tekst iz editora direktno u� �
prozor Nautilusa ime e se napraviti novi tekstualni� �
fajl.  Kretanje kroz direktorijume je olakšano posta-
vljanjem  menija  sa  dugmadi  koji  predstavljaju
pose ene direktorijume, kao u dijalozima sa odabir�

fajlova. Ovom opcijom, ali i mogu noš u da se doda� � -
ju pre ice u levi panel menadžera (Places), postiže se�
sli nost izme u radnog prostora fajl menadžera i di� � -
jaloga za odabir fajlova utvr uju i jedinstven "usabi� � -
lity" utisak. Posebu pažnju privla i i nova inovacija u�

okviru “list view” na ina pregleda sadržaja direkto� -
rijuma,  koja  omogu ava  preged  direktorijuma  di� -

rektno, klikom na marker pored ikonice direktoriju-
ma, bez potrebe za otvaranjem, prikazuju i poddri� -
rektorijume i fajlove koje lokacija sadrži. Nautilusov
alat za rezanje diskova sada podržava umnožavanje
audio diskova, pored diskova sa podacima.

Panel je, nalik  fajl  menadžeru,  pretrpeo nekoliko
sitnijih, ali veoma korisnih promena. Sada je mogu e�
postaviti panel vertikalno prilikom ega e i nazivi� �
menija biti prikazani vertikalno. Kada smo predsta-
vili GNOME 2.10 govorili smo o ponašanju novoo-

tvorenih aplikacija koje se od te verzije otvaraju u
pozadini ne ometaju i rad u drugim prozorima koji�
su ve  aktivni. Ova opcija je doživela malu inovaciju,�
pa e sada prozori koji se otvore u pozadini treptati�

u listi prozora, skre u i pažnju korisniku da je apli� � -
kacija pokrenuta. Dijalog za dodavanje apleta u pa-
nel je sada druga iji i poseduje polje za pretragu, pa�

je  posao  dodavanja  ovih
program i a olakšan. Meni� �

za  kreiranje  novih  fajlova
sa radne površine je dobio
ikonice  pored  imena  tipa
fajla,  dok alat  za pretragu
fajl  sistema  iscrtava  uma-

njeni  prikaz  prona enih�
slika umesto ikonica.

Dugo o ekivana i priželjkivana mogu nost pam e� � � -
nja materijala u clipboardu nakon isklju ivanja pro� -
zora iz kojeg je prenet je kona no dostupna. Ova mo� -

gu nost ne uti e negativno na brzinu rada, što je ra� � -
zvojnom timu okruženja GNOME bio imperativ pri
implementaciji ove opcije.

Aplikacije
Unapre enja nisu zaobišla ni podrazumevane apli� -

kacije,  pa  je sada dostupno nekoliko vrlo  korisnih
mogu nosti. Totem je dobio mogu nost prikazivanja� �
liste fajlova (playlist) kao i još bolju podršku za DVD

menije i  titlove,  a  mogu e je istovremeno slušati  i�
kompresovati  muziku sa  audio  diskova,  ak  i  na�
ra unare u mreži.�

Epiphany web browser je u novom izdanju kona-
no dobio mogu nost pretraživanja u okviru poseb� � -
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ne trake na dnu prozora. Ova opcija u velikoj meri

olakšava pretraživanje, a prisutna je u Firefoxu od
njegovog  prvog  izdanja,  te  je  mogla  i  ranije  biti
uklju ena. Epiphany sada koristi GNOME-ov sistem�
za štampanje što predstavlja još jedan korak ka boljoj
integraciji sa okruženjem.

Od ove verzije okruženja GNOME, podrazumeva-
ni alat za pregled PDF fajlova je Evince, koji predsta-
vlja  daleko  bolje  rešenje  od  prethodnih  programa
ove  namene  koji  su  dolazili  uz  GNOME.  Evince
omogu ava prikaz svih strana dokumenta u bo nom� �

panelu (thumbnails), dok je ovim alatom mogu e se� -
lektovati  i  kopirati  tekst iz  PDF fajla.  Slobodno se
može re i da je GNOME dobio alat za pregled ele� -
ktronskih dokumenata kakav zaslužuje.

Yelp je program koji služi za pregled help doku-
menata za  GNOME, i  u  novoj  verziji  donosi una-
pre eno prikazivanje help fajlova u skladu sa lokali� -
tetima, što zajedno sa sistemom za prevo enje obez� -
be uje kvalitetnu infrastrukturu za prevodioce.�

Igre u novom GNOME-u su pretrpele nekoliko iz-
mena, pa sada Mine bolje prikaziju otkrivena polja i

eksplozije, dok je Pasijans pametniji, sugerišu i kori� -

sniku gde bi trebalo postaviti kartu.

Podešavanja i prilago avanje�
Daleko najkorisnije i najobimnije inovacije pretrpeli

su alati za podešavanje i prilago avanje sistema. U�

ovoj verziji je uveden novi program koji obezbe uje�
potpunu  konfiguraciju  profila  korisnika.  Jednom
podešeni parametri e biti koriš eni u svim progra� � -
mima u kojima e biti zatraženi, što e skratiti posao� �
podešavanja. U skladu sa specifikacijama FreeDesk-

topa,  meniji  u  GNOME-u  e  sada  prikazivati  sve�
pre ice ka programima, bez obzira u kom okruženju�
se programi instaliraju. Saradnja izme u FreeDesk� -
topa je sve bolja i potpunija, pa GNOME sada koristi

Cairo API koji omogu ava nove efekte i bolje iscrta� -
vanje. Sami meniji su puno konfigurabilniji nego što
su bili do sada, zahvaljuju i novoj aplikaciji za ovu�
namenu koja je sastavni deo okruženja. Standardiza-
cija  menija  je  donela  mogu nost  pisanja  zasebnih�

aplikacija za ovu namenu, pa su se alternativne apli-
kacije ve  pojavile.�
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GNOME sada poseduje novi alat za manipulaciju
servisima koji omogu ava selekciju servisa koji e se� �

pokretati prilikom podizanja sistema. Pored servisa,
na red su došli i sistemski logovi jer je, pored aktuel-
nih, mogu e pratiti i arhivirane logove.�

Ispod haube je GTK u verziji 2.8 koji donosi nekoli-
cinu unapre enja koja predstavljaju sitnija poboljša� -

nja  funkcionalnosti,  kao  što  je  prikazivanje  teksta
prilikom prevla enja. Naro ito je zna ajna integraci� � � -
ja sa Cairo API-jem, koja e u budu nosti podi i gra� � � -
fi ke sposobnosti GNOME-a na znatno viši nivo.�

Nakon  koriš enja  nove  verzije  u  realnom  radu,�
možemo dati sve preporuke. GNOME je kao i uvek
bolji i brži, i kada se tome dodaju nove mogu nosti�
kojih  uistinu  nema  mnogo kao  pri  predstavljanju

verzije 2.10, dobija se razuman razlog za upgrade.
Kao i uvek, GNOME tim nas nije izneverio, donose i�
nam još bolji i korisniji GNOME.

Podrška za naš jezik je ura ena na visokom nivou,�
pa se i ova verzija može koristiti na srpskom jeziku,

na irili nom ili  latini nom pismu. Ekipa koja radi� � �
na lokalizaciji okružanja posao obavlja na visini za-
datka  i  njene  aktivnosti  možete  pratiti  na  adresi
http://www.prevod.org.

Za šest meseci o ekujemo 2.14, koji e doneti neko� � -
liko bitnih poboljšanja. Nadamo se da e zahvaljuju� -

i projektu Ridley, koji za cilj ima konsolidaciju broj a�
eksternih biblioteka koje mogu biti problemati ne, i�
još boljoj optimizaciji  kôda, GNOME biti  još brži  i
memorijski manje zahtevan. Do tada emo uživati u�
aktuelnoj verziji koja je ve  postala dostupna na ne� -

koliko distribucija.

Korisne adrese:
http://www.gnome.org
http://www.prevod.org

~Ivan Jeli�
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KADA  VOZITE  AUTOMOBIL  VEROVATNO  VIŠE VOLITE  DA

UJETE�  KAKO  MOTOR „ REŽI“, NEGO DA  NJEGOV RAD ZAGUŠI

JAKA  MUZIKA ,  JER JEDINO TAKO  ZNATE  U KAKVOM  SE

STANJU TRENUTNO  NALAZI  VAŠ MEZIMAC . ISTA JE SITUACIJA

I SA RA UNARIMA� .  DA BISTE ZNALI  KAKVO  MU  JE

„ ZDRAVLJE“, MORATE  NEPRESTANO PRED SOBOM DA  IMATE

DIJAGNOZU . POSTOJI VE I�  BROJ RAZLI ITIH�  ALATA  KOJI TO

OMOGU AVAJU� ,  ALI  SU ONI  UGLAVNOM  NEPOTPUNI  I

NEDORA ENI� ,  ILI  PREGLOMAZNI  I PREZAHTEVNI .  IPAK,
POSTOJI I ZLATNA  SREDINA -  GKRELLM.  OPET JE U

PITANJU  *NIX AKRONIM  OD „GNU K RELL MONITORS“,
KOJI OMOGU AVA�  NADGLEDANJE  RAZNIH  PROCESA I STANJA

HARDVERA .  POSTOJE SERVERSKI (GRELLMD)  I KLIJENTSKI

(GKRELLM )  MODUL . ZA  SERVERSKI MODUL  OD ZAVISNOSTI

JE POTREBAN SAMO  GLIB2,  DOK ZA  KLIJENTSKI TREBA

OBEZBEDITI JOŠ GTK2  I GDK2.  IPAK,  NAJVIŠE SE KORISTI

KLIJENT NA  DESKTOP MAŠINAMA ,  A  MOGU E�  JE

NADGLEDANJE  RESURSA UDALJENOG  RA UNARA�  TAKO  ŠTO

SE KLIJENT POVEZUJE SA SERVERSKOM INSTANCOM

PROGRAMA  (DAEMONOM )  NA  UDALJENOM  RA UNARU�

(RECIMO,  DA  VIDITE  SA POSLA KOLIKA  JE TEMPERATURA

PROCESORA I HARD  DISKA  NA  VAŠEM KU NOM�  RA UNARU� ).
PODRŽANO  JE PROŠIRIVANJE MOGU NOSTI�  PRIKLJU CIMA�

KAKO  KLIJENTA ,  TAKO  I SERVERA,  KAO  I PRILAGO AVANJE�

VIZUELNOG  IDENTITETA  PROGRAMA  SKINOVIMA .
ORGANIZOVAN  JE KAO  USPRAVNO ORIJENTISANI STUB

SASTAVLJEN OD NIZA  MONITORA  I GRAFIKONA  IJA�  SE

ŠIRINA  MOŽE  MENJATI .

Instalacija
Pošto je objavljen pod GNU GPL licencom, primar-

no se distribuira u obliku paketa izvornog kôda, ali
postoje i binarni paketi za GNU/Linux distribucije
Debian, Mandriva, RedHat, Yellow Dog, Slackware i
SuSE,  kao  i  za  *BSD  sisteme  FreeBSD,  NetBSD  i

OpenBSD. Naravno,  postoji  i  port  u binarnom pa-
ketu za Windows.

Instalacija iz izvornog kôda se svodi na pomalo ne-
standardan na in (nema ./configure koraka):�
$ tar xvjf gkrellm-2.2.7.tar.bz2

$ cd gkrellm-2.2.7

$ make

$ make install

Umesto etvrtog koraka možete napraviti  paket za�
svoju distribuciju. Na Slackwareu se to radi nared-

bama:
# make install DESTDIR=/tmp/gkrellm-2.2.7

# cd /tmp/gkrellm-2.2.7/usr

# makepkg -l y -c n ../gkrellm-2.2.7-i686-

1.tgz

I ostaje još da se instalira napravljeni paket:

# upgradepkg --install-new /tmp/gkrellm-

2.2.7-i686-1.tgz

Ceo ovaj proces traje nepunih 10 minuta.

More informacija
U samom GKrellM-u se krije 13 ra-

znovrsnih monitora, i to:
- naziv hosta i verzija kernela;
- datum i vreme;
-  grafik  zauzetosti  procesora  koji

može da prikaže poseban grafik  za
svaki  procesor (ako  ih  ima više) ili
kumulativni grafik za sve procesore;

-  informacije o temperaturi  proce-
sora i plo e, broju obrtaja ventilatora�

hladnjaka, ja ine napona i druge in� -
formacije koje  pružaju senzorski i� -
povi na mati nim plo ama (potrebni� �
lm_sensors ili mbmon), kao i tempe-
rature  hard  diska  (potreban  hdd-

temp)  i  procesora  NVidia  grafi kih�
karti (potreban nvidia-settings);

- grafik broja pokrenutih procesa i
prijavljenih korisnika;

-  grafik  upotrebe  diskova  (poje-
dina no za svaki disk ili kumulativni�
za sve diskove);

-  grafik  internet  saobra aja  (http,�
ftp, ...) koji prikazuje saobra aj preko�

odre enog tcp porta;�
- poseban grafik saobra aja za sva� -

ki  rutirani  mrežni  ure aj  sa  koli i� � -
nom poslatih i  primljenih podataka,
brzinom prenosa i  statistikim koli i� -

ne  prenetih  podataka po  danu,  ne-
delji i mesecu;

-  indikatori  zauzetosti  sistemske
memorije i swapa;

-  informacije  o fajl  sistemima koji

mogu da pokazuju kapacitet i slobo-
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dan  prostor  na  particiji/disku,  kao  i  mogu nost�

montiranja izmenljivih ure aja (CD, DVD, USB...);�

-  pra enje  lokalnih i  udaljenih sandu i a  e-pošte� � �
(podržani su mbox, maildir, MH, POP3 i IMAP);

- nadgledanje statusa baterije na laptop ra unarima�

preko APM-a sa alarmom za obaveštenje o statusu
oslabljene baterije;

- statistiku trajanja sesije OS-a (uptime).

Pored ovih ugra enih monitora, postoji veliki broj�

dodataka  koji  proširuju  mogu nosti  GKrellM-a,  a�
neki od najzanimljivijih su cpuspeed (brzina proce-
sora), Volume (kontrola ja ine zvuka), GKrellMMS�

(kontrola  plejera
XMMS),  GKrell-

Kam (prikaz  sli-
ka sa web kame-
re),  gkrelltop
(pokazuje tri naj-
aktivnija  CPU

procesa),  Ne-
wsticker  (prika-
zuje  naslove  ve-
sti  preuzetih  sa

sajtova  poput
Slashdota),  SE-
TI@home  (ime
sve  govori),
GKrellM-Wire-

less  (nadgleda
kvalitet beži ne veze) i mnogi drugi.�

Upotrebljivost
GKrellM nije zahtevan, brz je i stabilan i ne zauzi-

ma previše mesta na ekranu. Dijalog sa podešava-
njima se dobija  pritiskom na taster
F1 kada je aktivan prozor GKrellM-
a,  ili  izborom stavke Configuration
iz priru nog menija koji se dobija de� -

snim  klikom  na  okvir  programa.
Može se sakriti iz linije alata (taskbar
i pager), a podrazumevano ne koristi
dekoracije menadžera prozora zbog
zauzimanja  što  manje  prostora  na

ekranu. Može se postaviti iznad svih
drugih prozora,  ili  iza  prozora  iste
klase. Pozicija na ekranu se pamti pri
zatvaranju programa i pri slede em�

pokretanju otvara se na istom mestu.
Iako ovim programom ne ete  zara� -
diti  novac  svakako  vam  isti  može

uštedeti,  a kada se jednom naviknete,  GKrellM e�
postati sastavni deo Desktopa.

Korisna adresa:

http://members.dslextreme.com/users/billw/gkrellm/g
krellm.html

~Aleksandar Uroševi�
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OVAJ TEKST SE NE E�  BAVITI  MP3  MUZIKOM , DIVX-OM I

DVD- OM.  PA O EMU�  JE RE� ? O  PROGRAMU UZ  IJU�

ETE�  POMO�  NAPRAVITI  NOV  RAZMEŠTAJ U STANU,
NAPRAVITI  TOK PODATAKA  ZA  NEKI  PROCES,  DEFINISATI

RA UNARSKU�  MREŽU ,  NAPRAVITI  ŠEMU VODOVODNE

INSTALACIJE  U SVOJOJ ZGRADI ...  POKAZA EMO�  VAM  DA

LINUX  IMA  NEŠTO DOBRO ZA  VAS!

Dame i gospodo, Dia v.0.92.2 (trenutna verzija je

0.94), program baziran na gtk+ i objavljen pod GPL
licencom. Dia bi trebalo da podse a na mnogo po� -
znatiji  komercijalni  program "Visio"  za  win32 OS,
predvi en je da obavlja isti posao. Dia je implemen� -
tirana u okruženju GNOME (možete je koristiti i u

okruženju  KDE),  pod  ijim  se  pokroviteljstvom  i�
razvija, a postoji verzija programa i za Windows.

Dia se nalazi u meniju sa kancelarijskim aplikacija-
ma u sekciji Flowchart.

Kada pokrenete program dobijate dva prozora na
radnoj  površini.  Prvi  (Diagram  Editor)  sadrži  po-
trebne  alate  za  izradu  crteža,  a  drugi  prozor  je
površina za crtanje.

Diagram Editor
Diagram Editor možemo podeliti u šest zona:
1.Meni paleta
2.Polje sa alatima za crtanje i upravljanje objektima
3.Padaju i meni sa bibliotekama objekata�

4.Polje u kome su ikone sa objektima koje unosite
na crtež

5.Polje sa alatima za definisanje boje objekata i de-
bljine linija

6.Polje sa alatima za definisanje

izgleda linije
To je Vaš RAP za uspešan rad na

projektima za  koje  ste  zaduženi.
Program  je  predusretljiv  prema
korisniku,  dozvoljava  Vam  da

promenite osnovna podešavanja i
podesite  ga  prema svojim potre-
bama. Kada podesite mrežu za cr-
tanje  i  margine,  položaj  i  format

papira,  boju  pozadine,  spremni
ste za crtanje. Jedno objašnjenje, i
bez dodatnih podešavanja možete

se baciti na rad bez problema.

Virtuelna tabla za crtanje
Proces crtanja je vrlo jednostavan, kliknete na želje-

nu opciju, preselite se na svoju virtuelnu tablu za cr -
tanje, kliknete na mesto gde želite da zapo nete lini� -
ju  (mnogougao,  Bezijeovu  krivu,tekst...)  i  vu ete�
mišem do željene dužine (veli ine). Vidite da se teh� -
nologija crtanja ne razlikuje od drugih programa sli-

ne namene. Unos gotovih simbola na crtež funkcio� -
niše  po  principu klikni,  prevuci  i  spusti,  a  Vama
ostaje  da  iste  postavite  u  željeni  položaj.  Možete
umetnuti  i  grafiku  u  vaš  crtež  ako  to  želite.  Dia
pruža opciju crtanja u slojevima, što Vam zna ajno�

olakšava  rad  pri  izradi  složenih  procesnih  šema,
kada treba neki proces u initi "nevidljivim" i olakšati�
crtanje drugog procesa i/ili odštampati samo jedan
sloj crteža. Primer za to su instalacije sa više cevovo-
da  razli itih  namena.  Dia  dozvoljava  menjanje�

osnovnih karakteristika entiteta kao što su: debljina
linije, boja linije, boja popune, da li e entitet i mati�
pozadinu ili  e biti providan (transparentan), vrsta�
linije (puna, isprekidana...) i obrtanje objekta po ver -

tikalnoj ili horizontalnoj osi. Upravljanje izgledom li-
nije nije ograni eno samo na debljinu, boju i tip lin i� -
je,  možete  izabrati  jedan  od  tridesetak  tipova
završetka linija, naravno po potrebi.  Podržana je  i
opcija grupisanja delova crteža i njihovo "podizanje"

i/ili  "spuštanje"  u  odnosu  na druge entitete.  Kod
unosa teksta, Dia pruža osnovne mogu nosti ure i� � -
vanja. Zastupljene su opcije poravnanja teksta, izbor
fonta, izbor boje i veli ine kao i stila (bold, italic).  Bi� -
tno je napomenuti da tekst možete uneti bilo irili� -

nim,  bilo latini nim rasporedom tastature,  Dia  ih� �
prikazuje i štampa bez ikakvih problema. Pomo  pri�
crtanju vam pruža opcija Snap, koja lepi objekte na
preseke pomo ne mreže ili vorne ta ke ve  nacrta� � � � -
nih ili unetih entiteta. Opcija Snap je, u stvari, opc ija

za precizno crtanje. Dodatnu pomo  pri crtanju Vam�
pružaju horizontalni i vertikalni lenjiri, na kojima se
nalaze dve pokretne strelice koje u svakom trenutku
prate miš dok crtate.
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Snalaženje sa datotekama
Nakon pozivanja komande Save, Vaše je da date

ime  datoteci  a  Dia  se  pobrinula  za  ekstenziju.

Osnovna ekstenzija je .dia, a druga je .shape (o .sha-
pe e biti više re i u daljem tekstu). Osim .dia forma� � -
ta, datoteku je mogu e izvesti u preko dvadeset for� -
mata, a pomenu emo samo neke  - dxf, png, svg, tex,�
eps, fig, ps. Datoteku nije mogu e direktno sa uvati� �

kao PDF dokument, mora ete je prvo sa uvati kao� �
neko_ime.ps  datoteku,  a  zatim u terminalu  koma-
ndom ps2pdf neko_ime.ps konvertovati datoteku u
pdf format.

U se i u svoje kljuse
Ve  je re eno da Dia dozvoljava da je maksimalno� �

prilagodite sopstvenim potrebama, a jedan od na i� -
na  je pravljenje sopstvenih biblioteka simbola. Šta je
potrebno da bi se kreirala sopstvena biblioteka? Pa,

osim definisanja sopstvenih potreba, potrebno je da
simbole koji nedostaju nacrtate. Kada nacrtate sim-
bol  morate  ga  izvesti,  u  dijalogu Export  Diagram
izaberite direktorijum u koji smeštate simbole, a eks-

tenzija u kojoj se snima datoteka je .shape. Tu radnju
ponovite  onoliko  puta  koliko  Vam simbola  treba.
Možda deluje naporno? Krajnji rezultat  e vam iz� -
mamiti osmeh olakšanja. Slede i korak je otvaranje�
prozora File > Sheets and Objects u kome kreirate

svoju biblioteku simbola. Osim definisanja biblioteke
simbola, možete urediti svaki simbol posebno tako
što ete mu dati ime/objašnjenje koje e se pojavlji� � -
vati u balonu kada mišem stanete na isti. Imate i mo-
gu nost da postoje e simbole koje esto koristite, iz� � �

drugih prebacite u svoju biblioteku simbola.

Za kraj
Prvo  male  zamerke  na  ra un  radne  površine.�

Mnoštvo površina za crtanje koje se oslanjaju jedna
na drugu mogu zbuniti korisnika. Može se desiti da
crtež pre e granice formata i "preseli" se na drugu�
stranicu.  Iako  je  veli ina  stranice  definisana  gra� -
ni nim linijama, dolazi do greške pri crtanju koja za� -

tim povla i i grešku u štampanju, koja se manifestuje�
štampom crteža na više listova. Druga zamerka se
odnosi na odsustvo opcije za rotaciju entiteta sli na�
opciji  programa Inkscape.  Nemogu nost  direktnog�

prebacivanja dokumenta u PDF format ve  je pome� -
nuta.

Pomo  pozivate pritiskom na funkcijski taster F1 ili�
kucanjem man:dia  u  traci  za  unos  lokacija u  web
pretraživa u Konqueror. Dia, sasvim svojim biblio� -

tekama, automatski se  integriše  u 'vizioliki'  Kivio,
tako da i u tom programu možete korisiti svoje bibli-
oteke simbola, ukoliko ih Vi li no instalirate u odgo� -
varaju i direktorijum. Sve u svemu, solidan alat za�
izradu šematskih prikaza procesa, toka podataka i

jednostavnih mašinskih i gra evinskih crteža.�

Korisna adresa:

http://www.gnome.org/projects/dia/home.html

-Dejan Popadi�
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A KO JE DONEDAVNO  NAŠ INTERNET ŽIVOT  BIO NEZAMISLIV

BEZ ELEKTRONSKE POŠTE,  ONDA  JE SADA  POTPUNO

NEZAMISLIV  BEZ RAZNIH  SISTEMA ZA  RAZMENU  KRATKIH

PORUKA .  TAKVIH  SISTEMA JE TOLIKO  DA  PROSE AN�

KORISNIK  IMA  REALNIH  OSNOVA  ZA  GLAVOBOLJU . U MORU

PROTOKOLA  I PROGRAMA  POSTOJI JEDAN KOJI SE SVOJOM

FILOZOFIJOM I NA INOM�  RADA  IPAK  IZDVAJA  OD OSTALIH  I

KOJI,  INI�  SE DOSTA USPEŠNO,  POKUŠAVA  DA  SVE TE

SISTEME OBJEDINI U JEDAN, DOBRO URE EN� .

Protokol Jabber predstavlja verovatno najzanimlji-
viji  sistem za razmenu kratkih  poruka u realnom
vremenu koji postoji. On je fuzija ideja koje su stvo-

rene  oko  slobodnog  softvera  i  otvorenog  koda,  i
predstavlja jedinstveno rešenje za sve trenutne po-
trebe korisnika. Zašto je taj Jabber tako bolji od reci-
mo ICQ-a, MSN-a, Yahooa ili nekog drugog proto-
kola? Za po etak, slobodan je i  otvoren. To je ve� �

dovoljno dobar razlog da se na e na listi naših po� -
treba. Ipak, ne emo se zadržati samo na tim injeni� � -
cama, jer mnogima one ne e biti dovoljne. Pokuša e� � -
mo da vam na što jasniji  na in prikažemo koncept�
rada servera Jabber, i ubedimo vas da je baš to pravi

proizvod za vas i  vaše potrebe.
Kao kakvom trgovcu automobila, naša dužnost je

da vam na što koncizniji  na in objasnimo zašto je�
naš proizvod bolji od  konkurentskog. Ipak, kako je
vaše vreme dragoceno i kako je naša konkurencija fi-

nansijski mo nija, ne preostaje nam ništa do da po� -
kušamo i ubedimo vas da ostanete, i ujete kako Ja� -
bber radi, u nekoliko re enica:�

- Jabber je slobodan i otvoren - Jabberovi protokoli
su slobodni, otvoreni,  javni i  laki za  razumevanje,

omogu avaju mnogostruke implementacije za posto� -
je e klijente, servere, komponente i biblioteke koda.�

- Jabber je standardizovan -  Jabber teži standardi-
zaciji te je shodno tome IETF (Internet Engineering

Task  Force)  formalizovao XML protokole  kao  po-
tvr enu tehnologiju  za  instant  poruke  i  prisustvo�
pod imenom XMPP, a XMPP specifikacije su publi-
kovane kao RFC 3920 i RFC 3921

- Jabber tehnologija je potvr ena - prve Jabber teh� -

nologije su razvijene 1998. i sada se smatraju stabil-
nim; stotine programera radi na njima, desetine hi-
ljada Jabber servera radi na Internetu u ovom mo-
mentu,  milioni  zadovoljnih  korisnika  upotrebljava

Jabber.
Jabber je decentralizovan - arhitektura Jabbera je

sli na emailu; kao rezultat toga, bilo ko može da po� -
krene svoj li ni Jabber server i  time omogu i poje� � -

dincima ili  organizacijama da  kontrolišu  svoje  IM
prisustvo.

Jabber je bezbedan - svaki Jabber server može biti
izolovan sa javne Jabber mreže, robusna bezbednost
SASL-a i TSL-a je integrisana u XMPP specifikacije.

Jabber je proširiv  -  zbog injenice da koristi  mo� �
XML-a, Jabber ostavlja svakome mogu nost da na� -
piše dodatke koje može dodati na jezgro protokola.

Jabber je  fleksibilan -  Aplikacije  koje podržavaju
Jabber prevazišle su instant messaging (IM), i sadrže

sindikaciju  sadržaja,  kolaboracione alatke,  deljenje
datoteka, igre, nadgledanje udaljenih sistema...

Jabber je razli it - veliki broj kompanija i projekata�
otvorenog koda koriste  Jabberove protokole da  bi

gradili aplikacije i servise.
Verujemo da je ovo i više nego dovoljno da probate

Jabber. Ali ne emo biti površni prodavci i zaustaviti�
se ovde. Sada kada imamo vašu pažnju, predlažemo
da se proizvod raspakuje i pogleda kako on radi.

Brzi pregled rada sistema Jabber
Arhitektura Jabbera umnogome podse a na najte� -

stiraniju tehnologiju svih vremena: email. Ipak, ima
puno bitnih razlika, te ete pogrešiti ako izjedna ite� �

Jabber sa  sistemom elektronske pošte. Ako želimo
da razumemo kako Jabber zaista radi, po imo od je� -
dnog jednostavnog primera: Romeo i Julija u uve� -
noj sceni sa balkonom.

U svetu Jabbera, Julija ne e slati poruke direktno�

Romeu. Julija ima nalog na Jabber serveru, a njena
Jabber identifikacija (JID) dosta li i na email adresu -�
njen JID je   juliet@capulet.com gde je  capulet.com
njen porodi ni server. I Romeo ima svoj nalog, samo�
na svom serveru, i njegov JID e biti romeo@monta� -

gue.net.
Kada se jednom Julija prijavi na capulet.com ona

svom ljubljenom može slati  poruke.  Budimo sada
malo precizniji oko toga šta se tu ta no dešava kada�

Julija sa svog laptopa zapo ne slanje poruka sede i� �
na balkonu:

1. Julija šalje poruku na adresu romeo@montagu-
e.net
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2. Za poruku se stara Jabber server na capulet.com
3. capulet.com server otvara vezu prema montagu-

e.com ukoliko ista ve  nije otvorena�
4.  Ukoliko uzmemo za pretpostavku da mame i

tate  nisu  isklju ile  komunikaciju  server-server  iz� -
me u capulet.com i montague.com, Julijina poruka�
se preusmerava na Jabber server montague.com.

5. montague.com server vidi da je poruka namenje-
na korisniku "romeo", i dostavlja je na Jabber klijent
koji radi na Romeovom PDA ure aju koji se pak na� -
lazi podno balkona.

6 .  Poruka se pojavljuje na Romeovom ekranu, i
Romeo se raspame uje što od sre e što je stigla poru� � -
ka, što zbog injenice da je upravo shvatio kako mu�
se iza le a nalaze dva ove a rotvajlera porodice Ca� � -
pulet.

Kao što se da primetiti u ovoj više nego ozbiljnoj si-
tuaciji ima dosta doga aja: razli iti klijenti na razli i� � � -
tim operativnim sistemima, komunikacioni kanal iz-

me u dva servera i dvoje ljubavnika. Jabber pokriva�
sve sem ovog poslednjeg. Evo kako bi to slikovito iz-
gledalo:

Kao što se na slici može videti, arhitektura Jabbera
je istovetna arhitekturi email sistema. Obe vrste ko-

munikacije su omogu ene putem distribuiranih mre� -
ža  servera, koriste i zajedni ke protokole. Poseban� �
klijent se povezuje na server kako bi primio poruku
od drugog korisnika, i poslao poruku korisnicima na
istom serveru ili na bilo kom drugom serveru koji j e

povezan na mrežu.
Ipak, razlika je evidentna. Sistem elektronske pošte

je baziran na uvanju i prosle ivanju podataka, dok� �
Jabberovi  serveri  rade  skoro  u  realnom vremenu.
Ovo je mogu e jer Jabberov klijent zna kada ste na�

vezi. To njegovo saznanje se naziva dostupnost, i to
je  klju ni aspekt  koji  omogu ava da slanje poruka� �

bude "instant".
Jabber kombinuje ove standardne IM karakteristi-

ke sa još tri specifi nosti koje ine Jabber tehologije� �
jedinstvenim. Prva specifi nost su protokoli koji su�
otvoreni, dobro dokumentovani i laki za razumeva-
nje. Druga je to što su Jabber protokoli 100% XML,
omogu avaju i  nesmetanu  komunikaciju  kako  iz� � -

me u  ljudi  tako  i  izme u  aplikacija.  Tre a  spe� � � -
cfi nost  je  to da  Jabber koristi  adrese bazirane na�
DNS i prepoznatim URI šemama, što za rezlutat ima
adrese  istog formata  kao i  one koje  se  koriste  za

email (korisnik@host).

Klijent/Server
Jabber  tehnologije  su  bazirane  na  principu

klijent/server. To zna i  da ne koriste direktnu ko� -

munikaciju  kao  neki  drugi  sistemi  ve  da  poruka�
koju šaljete mora pro i kroz barem jedan server. Ja� -
bber  klijent  se  povezuje  sa  serverom  preko  porta
5222 dok se serveri me usobno povezuju preko por� -
ta 5269. Ova veza je stalna dokle god je klijent pove-

zan sa serverom. Prosto re eno, klijent ne mora kao�
kod emaila stalno da traži poruke, ve  se svaka po� -
ruka poslata  vama bukvalno istog trena preusme-
rava na vaš klijent. Server vodi ra una o tome da li�
ste povezani ili ne, te u onom trenutku kada više ni-

ste na vezi on po inje sa uvanjem svi poruka koje� �
vam pristižu i dostavlja ih onog trena kada se pono-
vo povežete na njega.

Otvoreni protokoli
Jabber tehnologije su stvorene u zajednici otvore-

nog  koda  i  samim  tim  omogu ile  razvoj  za  sve�
postoje e platforme. Jedna od stvari koju je Jabberov�
razvojni tim uradio jeste definisanje otvorenog pro-

tokola  za  slanje  XML  podataka  preko  "žice".  Od
po etka  rada do danas  protokol  je  nastavio da  se�
razvija kako u dubinu tako i u širinu. Dubina u su-
štini poti e od posla koji je XMPP Radna Grupa od� -
radila sa  IETF (Internet Engineering Task Force); srž

XML sistema protokola  je  objavljen  kao "Proširivi
Protokol za Poruke i Prisutnost" (XMPP - Extensible
Messaging  and  Presence  Protocol),  a  IETF  ih  je
odobrio  kao  RFC  3920  i  RFC  3921.  Širina  dolazi
uglavnom od rada Softverske Fondacije Jabber u de-

finisanju  proširenja  samoj  srži  protokola  dodava-
njem niza pogodnosti za korisnike.

XML format podataka
XML je integralni deo Jabber tehnologija. Možda e�
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neko pitati zašto? Odgovor je jako jednostavan. XML
omogu ava  da  Jabber  tehnologije  budu  potpuno�

proširive i u mogu nosti da prikažu skoro svaku vr� -
stu strukturisanih podataka.  Kada se klijent  pove-
zuje na server, on otvara jednosmeran XML kanal a
server  odgovara  svojim jednosmernim XML kana-
lom prema klijentu. Dakle, sva komunikacija se od-

vija kroz ta dva kanala u obliku malih komada (sta-
nze) XML-a, kao što je to poruka Julije Romeu:
<message from='juliet@capulet.com'

to='romeo@montague.net'>

 <body>Wherefore art thou, Romeo?</body>

</message>

Kao što se vidi, Jabberove stanze mogu biti jako je-
dnostavne.  No,  zbog koriš enja  XML-a  ostavlja  se�
mogu nost proširivanja komunikacije i prilago ava� � -

nja sistema sopstvenim potrebama. Ovo omogu ava�
da Jabber platforma može da šalje bilo kakve struk-
turisane podatke uklju uju i XML-RPC i SOAP, pro� � -
ceduralne pozive, RSS sindikaciju i SVG slike.

Distribuirane mreže
Kao što  smo ranije  videli,  arhitektura Jabbera  je

jako sli na onoj koju koriste email sistemi. Svaki ko� -
risnik se povezuje na svoj "doma i" server, koji za�
njega prima informacije, a serveri me usobno, u ime�

korisnika,  razmenjuju podatke.  Zbog toga bilo koji
domen može da pokre e Jabber server, pošto svaki�
server  funkcioniše  nezavisno  od  ostalih  i  održava
sopstvene liste korisnika. Kao dodatak tome, Jabber
server može da komunicira sa bilo kojim Jabber ser-

verom koji je dostupan putem Interneta. Odre eni�
korisnik je povezan sa odre enim serverom, a Jabber�
adrese su u istom obliku kao email adrese. Rezultat
je  fleksibilna  mreža  servera  koja  može  da  skalira

mnogo  više  nego  monolitni  centralizovani  servisi
koje pružaju kompanije kao što su AOL, Microsoft,
Yahoo...

Modularni servisi
Jabber server igra tri glavne uloge:
- Stara se o vezi sa klijentima i direktno komunicira

sa Jabber klijentima.
- Komunicira sa ostalim Jabber serverima.
- Koordinira razli ite komponente koje su u vezi sa�

serverom.
Jabber serveri su dizajnirani da budu modularni sa

specifi nim internim paketima koda koji se staraju o�
funkcionalnostima kao što  su registracija,  provera
identiteta, kontakt liste, uvanje poruka i sl. Možda�

najzanimljivija karakteristika  Jabber servera je mo-
gu nost  njegove  nadogradnje  dodacima  koji  mu�

onda zauzvrat omogu avaju funkcije kao što je rad�
kao server za ostale sisteme poruka (ICQ, MSN, Ya-
hoo...). To omogu ava proširenje mogu nosti Jabber� �
sistema bez narušavanja njegove jednostavnosti i bez
potrebe da se dobija "blagoslov" od razvojnog tima

Jabbera.  Dakle,  fleksibilnost je klju na re  projekta� �
Jabber.

Jednostavni klijenti
Jedan od uslova Jabber sistema je bila i mogu nost�

da se lako pišu klijenti. I zaista, jako je malo ogra-
ni enja koja name e Jabber pri pisanju klijenata:� �

- Komunikacija sa drugim Jabber serverima preko
TCP-ja.

-  Raš lanjivanje  i  interpretacija  dobro  formiranih�
XML "stanzi" putem XML kanala.

-  Razumevanje  osnovnih  Jabber  vrsta  podataka
(poruka, prisutnosti itd.).

Cilj Jabbera je da se kompleksnost prebaci sa kli-

jenta na server. Ovo zna i da je relativno lako napi� -
sati Jabber klijent, kao i ažurirati isti. To je svakako
dovelo do niza fantasti nih klijenata koji pokrivaju�
potrebe svih nas. Vama ostavljamo da izaberete koji
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JID elementi su definisani na slede i na in:� �
-  Identifikator  Domena  je  primarni  identifikator.

Predstavlja Jabber server na koji se entitet povezuje.
Svaki upotrebljiv  Jabber server  treba da usmerava

na potpuno kvalifikovano ime domena.
-  Identifikator  vora  je  drugi  identifikator.  On�

predstavlja "korisnika". Svi vorovi se nalaze u od� -

re enom Domenu.�
Tre i  neobavezni  identifikator�

je Identifikator Izvora. Svi Izvori
pripadaju voru. Unutar Jabbe� -
ra  Identifikator  Izvora  služi da
prepozna odre eni  objekat  koji�
pripada  korisniku  kao  što  su

ure aji  ili  lokacije.  Izvori  omo� -
gu avaju  da  korisnik  može  si� -
multano  da  održava  nekoliko
veza sa Jabber serverom npr. ju-

liet@capulet.com/balcony vs. ju-
liet@capulet.com/chamber.

Jabber, pravi proizvod za
Vas!

Naš  proizvod  je  pravi  pro-
izvod za  vas.  Jabber vam nudi
elegantan,  mo an  ali  jednosta� -
van na in komunikacije sa sve� -
tom.  On  e  vas  lištiti  mnogih�

problema (ne garantujemo da e�
vas spasiti rotvajlera) u komuni-
kaciji sa prijateljima, poslovnim
saradnicima,  ro acima.  Jabber�
predstavlja sistem za komunika-

ciju koji je pre svega slobodan i
otvoren,  a  nadasve  izuzetno
bezbedan. Ukoliko se dvoumite,
da  li  je  to  pravo  rešenje
predlažemo da probate neki od

navedenih  klijenata.  Izbor  servera  je  zaista  fanta-
sti an ali emo vam ipak preporu iti jedini doma i� � � �
Jabber server - jabber.elitesecurity.org, koji nudi sve
važne Jabber usluge kao što su SSL komunikacija,

komunikacija  sa  ICQ,  MSN,  Yahoo  protokolima,
konferencijska veza i sl.

~Marko Milenovi�
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Firefox 1.5 beta 1

Ako želite malo da zavirite u budu nost i vidite šta�
vas eka u slede oj inkarnaciji najpopularnijeg web� �
pretraživa a  za  platforme  otvorenog  koda,  preuz� -
mite Firefox 1.5 beta 1  sa sajta  fondacije Mozilla i

uživajte. Kada ga budete prvi put pokrenuli, sa e� -
ka e vas arobnjak za ažuriranje (update) ekstenzija� �
koji e pogledati da li  postoje nove verzije koje su�
modifikovane da rade pod Firefoxom 1.5.

Sam Firefox u novoj verziji ne donosi skoro ništa
vidljivo novo. Kada ga pokrenete, do eka e vas ap� � -
solutno isti prozor kao i ranije. Što se samog okruže-
nja ti e, malo ve e izmene je doživeo samo dijalog za� �
podešavanja (Preferences) koji je pravljen po specifi-

kacijama Gnome User Interface Guidelines.
Glavni razlog za pove avanje broja verzije sa 1.0�

na 1.5 je bio novi Gecko koji sada još bolje podržava
standarde  propisane  od  strane  organizacije  W3C.
CSS2 je skoro u potpunosti  podržan,  a dodati su i

neki elementi iz predloga za CSS3 standard (specifi-
kacija CSS3 još nije finalizovana).

Licenca: MPL i NPL
Adresa: http://www.mozilla.org/

Beep Media Player 0.9.7

Još jedan u nizu audio plejera nastalih da zamene
zastareli XMMS. Koristi XMMS/Winamp skinove, a
organizacija  samog prozora  je  apsolutno  identi na�
pomenutim programima. Prednost BMP-a u odnosu

na XMMS je podrška za ID3 v2 tagove u mp3 fajlovi-
ma, kao i to da je BMP GTK2 program tako da su
prozori za podešavanja znatno ugla eniji od XMMS-�
a.

Licenca: GPL
Adresa: http://beepmp.sourceforge.net/

NKRecnik 0.85

NKRecnik je doma i�  dvosmerni englesko-srpski re-

nik pisan za okruženje KDE. Ne može se baš po� -
hvaliti nekim dobro dizajniranim prozorom, kao ni
brzinom pretrage baze, ali služi svrsi. Velika mana je
nemogu nost  traženja  dela  neke  re i  -  ne  možete� �
ukucati  "prec"  i  o ekivati  da  dobijete  prevod  re i� �

"precious".

Licenca: GPL
Adresa: http://nkrecnik.sourceforge.net/

LGeneral 1.2beta3
LGeneral  je  potezna  strategija  inspirisana  igrom

Panzer General, ije scenarije može i da u itava. Cilj� �
igre je standardan - napravite vojsku, zauzmite ne-
prijateljsku teritoriju i, na kraju, uništite neprij atelja.

U svakom slu aju, vredi pogledati.�
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Licenca: GPL
Adresa: http://lgames.sf.net/

Joomla! 1.0
Projekat Joomla! je nastao na ruševinama Mambo

CMSa (o emu ste mogli da itate u prošlom broju� �
magazina  GNUzilla).  Programeri  koji  su  radili  na

Mambu su se odvojili  od mati ne kompanije i  na�
osnovu poslednje verzije Mamba napravili  su "po-
tpuno novi", "više puta nagra ivani" CMS.�

Licenca: GPL
Adresa: http://www.joomla.org/

~ Ivan uki� �
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GNOME 2.12
Jedna od lepih vesti  koja je ozna ila�

septembar je svakako izlazak nove ver-
zije  popularnog  grafi kog  okruženja�
GNOME.  Neko  e  re i  da  GNOME� �

poslednjim verzijama ne donosi ništa revolucio-

narno. Valjda se GNOME tim samo zagreva za
verziju 3 o kojoj se ve  dugo tako puno pri a.� �
Ipak,  ko  je  redovno ažurirao  pakete  u  verziji
2.10 mogao je da primeti lagano širenje aplikaci-
ja, i injenicu da GNOME lagano postaje kom� -

paktnija celina. Nova verzija e biti prepoznatilj� -
va po novom izgledu GNOME okruženja pošto
je Clearlooks, jedna od najpopularnijih tema za
GNOME, uklju ena u njega. Dosta je ura eno i� �
na polju rada sa datotekama, itanja dokumena� -

ta i  sl. Ukoliko ste ljubitelj GNOME okruženja
preporu ujemo vam da probate verziju 2.12.�

Debian i robna marka
Od kako je gospodin Torvalds pokre-

nuo pitanja robne marke i zaštite autor-
skog prava na Linuxu, ini se da su svi�
odjednom za trenutak ostavili  rad  na

softveru i po eli da prelistavaju svoje pravne ak� -

te. Branden Robinson, vo a projekta Debian, je�
nedavno izjavio da e dokument koji se odnosi�
na Debian kao robnu marku uskoro biti ažuri-
ran kako bi obezbedio zažtitu od potencijalnih
pravnih pretnji. Jedno od najve ih pitanja koja�

se postavljaju u Debianovoj zajednici jeste da li
Debian uopšte treba da ima robnu marku ili ne,
kao i da li bi ona mogla da se koristi u sankcio-
nisanju svih onih koji "vrebaju" zajednicu.

Opera 8.5
Po mnogima jedan od najboljih

pretraživa a je doživeo svoju 8.5�
verziju. To i nije tako za u uju a� � �
vest.  Ipak,  nova  verzija  donosi

nešto što ranije  nisu imale.  Ta nije  ne donosi.�
Opera 8.5 dolazi bez reklama, potrebe za pla a� -
njem i registracijom.

Mozilla i dalje u sedlu
Mnoge poštovaoce standardnog iz-

danja  Mozille  je  zaprepastila  vesto

koju je objavila Mozilla Fondacija i koja je najavila prest a-
nak rada na Mozilla Suite softveru. No, zajednica to nij e
mogla da dozvoli, te je rad na ovom fenomenalnom pre-
traživa u ipak nastavljen pod nazivom SeaMonkey. Da je�

rad bio uspešan govori i injenica da je na servere posta� -
vljena 1.0 Alfa verzija novog pretraživa a. Razvojni tim�
Mozilla SeaMonkeyja napominje da je ovo jako nestabi-
lan softver, ali vas poziva da ga testirate.

KDE 3.5 Beta 1 - Kanzler
Izgleda da e ovo biti mesec pun noviteta na�

polju grafi kih okruženja. Dve nedelje pošto je�
izašao novi GNOME i razvojni tim KDE-a je ob-

javio prvu beta verziju ovog prelepog grafi kog okruže� -
nja. Ipak, razvojni tim upozorava sve one koji namerava-
ju da probaju ovo beta izdanje da usled injenice da su�
Qt biblioteke verzije 3.3.5 izašle u poslednji as, adaptira� -
nje KDE 3.5 Beta 1 na njih nije baš najbolje završeno, te je

mogu e da ete imati probleme ukoliko koristite nove Q t� �
biblioteke i novi KDE.

Slackware 10.2
I  pored  mnogih problema kroz  koje  je  pro-

lazio, Slackware Linux,  najstarija Linux distri-
bucija, nastavlja da se razvija i  živi. Sredinom
septembra je objavljena verzija 10.2 ove distri-

bucije.  U  pakovanju od  4  diska  dolaze Linux  2.4.31  i
Linux  2.6.13,  Mozilla  Suite  je  zamenjen  Firefoxom  i

Thunderbirdom. Kao što je ranije najavljeno verzije 10.x
su poslednje izgra ene na starim principima. Slackware� -
ov razvojni tim je najavio ozbiljniji rad i velike prepr avke
u verziji 11. Ostaje nam samo da ekamo i vidimo šta je�

to razvojni tim ove distribucije smislio.

Završen Google Summer Of Code (SOC)
Bilo je ovo jedno vrelo programersko leto.

Google  je  organizovao zaista  zanimljiv  do-

ga aj - Summer Of Code. I pored nekih organizacionih�
problema SOC je privukao ogroman broj studenata iz i� -
tavog sveta kao i  veliki  broj projekata. I pored uspeh a
programa ostaje da se vidi ho e li se ovaj doga aj pono� � -
viti i naredne godine.

~Marko Milenovi�
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KVALITET  NOVOG  STABILNOG  IZDANJA  DISTRIBUCIJE

DEBIAN  POMEŠAN SA OKOLNOSTIMA  KOJE SU SE NA  SCENI

DOGODILE  U VREME OBJAVLJIVANJA ,  USLOVIO JE PORAST

KORISNIKA  OVE DISTRIBUCIJE.  POVE ANJEM�  BROJA

KORISNIKA  PORASLA JE I POTREBA ZA  DOKUMENTACIJOM

KOJA BI MANJE ISKUSNIM  KORISNICIMA  OLAKŠALA  ŽIVOT .
KAKO  SE ISPOSTAVILO, NAJVIŠE PROBLEMA SE JAVLJALO OKO

INSTALACIJE  PAKETA , PA EMO�  SE OVOM  PRILIKOM  DOTA I�

DATE  TEMATIKE  U POKUŠAJU DA  ŠTO BOLJE PRIBLIŽIMO

INSTALACIJU  SOFTVERA NA  DEBIAN  SISTEMIMA  MANJE

ISKUSNIM  KORISNICIMA .

Nivo znanja, kao i afiniteti korisnika uzrokuju sim-

patije ili averzije ka konzoli kao najvažnijem alatu na

stavlja jedan od prvih binarnih formata koji se poja-

vio na sceni, pored RPM-a naravno. Instaliranje ovih
paketa se može obaviti na više na ina, u zavisnosti�
od želja i mogu nosti korisnika. Debianovi paketi se�
nalaze na instalacionim diskovima distribucije koja
se koristi ili na serverima sa kojih se paketi preuzi-

maju ili instaliraju, nekim od alata sa kojima emo se�
sresti u nastavku pri e. Distribucija softvera u obliku�
binarnih paketa je puno prakti nija za korisnike, jer�
je  proces  kompajliranja  softvera  umesto  korisniku

prepušten razvojnom timu distribucije, koji umesto
izvornog koda isporu uje  iskompajlirani  softver  u�
binarnom obliku, pa se ovakvi paketi nazivaju binar-
ni. Za neupu ene, izvorni kod programa, napisan u�

nekom programskom jeziku (source) se mora preve-
sti na jezik razumljiv ra unaru (binarni kod) da bi se�
uopšte mogao izvršavati i korisiti. Ovaj proces se na-

ziva kompajliranje (eng. compile), ili prevo enje, što�
je za sada jedini adekvatan izraz u srpskom jeziku.
U skladu sa filozofijum slobodnog softvera, javno su
dostupni i paketi sa izvornim kodom programa.

GNU/Linux,  kao  i  ostali  POSIX  kompatibilni

sistemi,  su  poznati  po  me uzavisnostima  paketa,�
odnosno pojavama da program ne e raditi ukoliko�
na sistemu nemate odre enu verziju potrebne biblio� -
teke ili  nekog drugog programa na koji  se  željeni
program oslanja. Softver od kog zavisi rad željenog

programa se tako e mora instalirati i tu nastaje po� -

mogu obaviti bez problema.

Kako na i programe�
Kao što je ve  pomenuto, .deb paketi  se u ve ini� �

slu ajeva nalaze na diskovima kojima se distribuira�
sistem (Debian Sarge se distribuira na 14 CDROM-

ova ili 2 DVD diska) ili na repozitorijumima ("skla-
dištima")  namenjenim  distribuciji  koja  se  koristi.
Zvani ni repozitorijumi se postavljaju na serverima�
koje  održava  distribucija,  i  pristupa  im  se  preko
interneta. Na njima su smešteni prakti no svi dostu� -

pni paketi,  odnosno aplikacije, koje postoje za od-
re enu distribuciju u binarnom obliku. Postoje i ne� -
zvani ni repozitorijumi na kojima se nalaze paketi�
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za iju stabilnost ne odgovara razvojni tim distribu� -
cije.  Suština repozitorijuma je da se paketi  organi-

zuju prema odre enim pravilima ime se obezbe u� � � -
je  standardizovan sistem pristupa i  koriš enja  pa� -
keta. Bilo da se radi o repozitorijumu ili diskovima,
obezbe eno je  potpuno prisustvo  svih  paketa  po� -
trebnih  za  zadovoljavanje  me uzavisnosti  koje  se�

mogu javiti  prilikom instalacije  željenih programa.
Tipi na adresa repozitorijuma može izgledati ovako�
deb http://www.bootsplash.de/files/debian/

unstable main

i ovakve ili sli ne adrese služe za pristupanje i ko� -
riš enje paketa koji se na njima nalaze, pomo u ne� � -
kih od dostupnih alata za instalaciju paketa.

Diskovi mogu biti lakša varijanta kada je instalacija
paketa u pitanju, naro ito korisnicima koji imaju sla� -

bu internet vezu. Diskovima se pristupa malo dru-
ga ije, što zavisi od alata za manipulaciju paketima�
koji  se  koristi.  Globalno  je  lakše  koristiti  diskove
ukoliko se izuzme slu aj sa 14 CDROM-ova distribu� -
cije Debian, ije menjanje prilikom instalacije može�

biti prili no dosadno. Naravno, veliki broj diskova, a�
samim tim i  paketa ima i  svoje prednosti, naro ito�
korisnicima koji nemaju brzu vezu ka internetu.

Konzolni alati
Instalacija paketa iz konzole je na in kojem pribe� -

gavaju pre svega napredniji korisnici jer pruža od-
re en nivo kontrole koji grafi ki alati ne pružaju, što� �
se pre svega ti e otklanjanja potencijalnih problema�
do kojih može do i.�

U osnovi, pojedina ni .deb paketi se instaliraju po� -
mo u alata dpkg, komandom:�
#dpkg -i ime_paketa.deb

Instalacija paketa na ovaj na in se ne preporu uje jer� �

može izazvati probleme ukoliko zavisnosti nisu pri-
kladno zadovoljene. Ovakav na in instalacije se kori� -
sti kada željeni paket nije mogu e na i ni na jednom� �
dostupnom repozitorijumu ili  na diskovima na ko-
jima se sistem distribuira, ili  ukoliko je .deb paket

potrebno  napraviti  iz  izvornog  koda  programa,
usled nepostojanja binarnog formata željene aplika-
cije. Za sve ostale namene treba koristiti neki od ala-
ta koji obezbe uju zadovoljavanje zavisnosti.�

APT (Advanced Package Tool) je jedan od najsa-

vršenjih sistema za menadžment paketa današnjice.
Slavu je stekao na distribuciji Debian, mada se kori-
sti i na distribucijama baziranim na alatu RPM, što
dovoljno govori o njegovoj pouzdanosti i kvalitetu.
Postoji nekliko vrlo kvalitetnih konzolnih alata koji

koriste biblioteku APT prilikom manipulacije paketi-
ma, a u svakodnevnoj praksi se naj eš e koriste apt-� �

get i apt-cache, dok se za manipulaciju diskovima sa
paketima koristi apt-cdrom.

Kao što je ve  pomenuto, apt-get je konzolni alat�
koji koristi biblioteku APT za rad sa paketima i odli -
kuje se velikim brojem vrlo korisnih opcija. Postoji

nekoliko su elja za apt-get koja bi trebalo da olakša� -
ju koriš enje ovog alata, kao što su dselect ili aptitu� -
de u konzoli, ili Synaptic, GNOME-APT ili Kynaptic
koji koriste grafi ki interfejs. Konzolne front-end al a� -

te ne emo pominjati ovaj put, jer je koriš enje alata� �
apt-get veoma lako. O grafi kim apt alatima e biti� �
re i u narednom broju.�

Da bi se bilo koji program instalirao, potrebno je da
informacije o paketima, odnosto programima postoje

u apt bazi. Prvo korak ka postizanju cilja je pružanje
informacije odakle se paketi instaliraju, odnono da je
u pitanju  instalacija sa diskova ili  preko interneta.
Ukoliko se koriste diskovi, presudnu ulogu igra alat
pod  nazivom  apt-cdrom.  Prilikom  instalacije  sis-

tema, svi diskovi  e  biti  dodati  u  bazu  od  strane�
instalera. Ukoliko je nakon instalacije potrebno do-
dati novi disk u apt bazu, potrebno je ukucati u kon-
zoli
#apt-cdrom add

i pritisnuti enter, nakon ega e sistem zatražiti da se� �
disk ubaci u drajv i ponovo pritisne enter, kako bi
informacija o disku bila zapisana u fajl /etc/apt/so-
urces.list. Isti postupak je potrebno uraditi za ostal e
diskove ukoliko ih ima, nakon ega je potrebno iz� -

vršiti komandu
#apt-get update

kako bi informacije o paketima sa medijuma bile za-
pisane u apt bazu.

Ukoliko se instalacija paketa obavlja preko interne-
ta, potrebno je uneti adresu/e repozitorijuma u po-
menuti fajl /etc/apt/sources.list i upisati informacij e
o paketima komandom
#apt-get update

Adrese repozitorijuma se skoro uvek mogu na i na�
sajtu distribucije koja se koristi, ili na sajtu aplik acije
koju korisnik želi instalirati, ukoliko ta aplikacija ne
postoji u oficijelnim repozitorijumima. Uvek je pre-
poru ljivo koristiti instalaciju paketa preko repozito� -

rijuma, zbog zadovoljavanja me uzavisnosti.�
Nakon uspešno završenog popunjavanja apt baze

informacijama o paketima, mogu e je pretraživanje�
baze paketa u potrazi za željenim programom. Uko-
liko treba instalirati Inkscape, na primer, potrebno j e
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izvršiti komadu
#apt-cache search inkscape

nakon ega e na ekranu biti izlistana imena svih pa� � -
keta  koji  imaju  veze  sa  pomenutim  programom.
Instalacija Inkscapea se obavlja komandom
#apt-get install inkscape

pri emu e automatski biti instalirani svi paketi od� �

kojih zavisi uspešno koriš enje ovog programa. APT�
e korisniku prikazati spisak paketa koji e biti do� � -

datno instalirani, radi zadovoljenja zavisnosti, kao i
spisak preporu enih paketa koji bi mogli biti korisni�

za  rad  željenog programa.  Ovi  paketi  se  u ve ini�
slu ajeva ti u  proširenja  mogu nosti  željenog pro� � � -
grama i  ne  instaliraju  se  automatski,  jer  program
može  da  funkcioniše  i  bez  njih.  Obi no  je  dobro�
instalirati i  ove pakete jer se time postiže potpuna

funkcionalnost željenog programa. Ukoliko se insta-
lacija  vrši  preko  interneta,  preuzeti  paketi  e  biti�
smešteni u folderu /var/cache/apt. Brisanje paketa
iz ovog foldera se obavlja komandama
#apt-get clean ili

#apt-get autoclean

sa razlikom što e koriš enjem opcije autoclean biti� �
obrisani samo paketi koji više ne postoje u repozito-
rijumu pa su stoga beskorisni.

Deintalacija paketa se tako e može isvesti na neko� -

liko  na ina.  Ponovo  je  preporu ljivo  ne  koristiti� �

dpkg, ve  apt-get ako se radi u konzoli. Ukoliko je�
potrebno deinstalirati inkscape, na primer, treba iz-

vršiti slede u komandu:�
#apt-get remove inkscape

Na ovaj na in e biti  uklonjeni i  paketi  koji  su di� � -
rektno vezani za inkscape, ime je sistem deinstalaci� -
je  vrlo dobro automatizovan.  Uklanjanje programa

se uvek može uraditi alatom dpkg komandom
#dpkg -r inkscape

Treba primetiti  da  je  prilikom instalacije pojedina-
nih paketa  potrebno navesti  potpuno ime paketa�

koji se instalira, dok to nije slu aj sa deinstalacijom.�
Kada uklanjate program, dovoljno je uneti ime pa-
keta u obliku u kom se dobija kada se izvrši koma-
nda
#apt-cache search

Ukoliko je potrebno ukloniti  sve podatke koji  su
vezani  za  odre eni  probram  zajedno  sa  njim,�
uklju uju i  i  konfiguracione fajlove,  treba  koristiti� �
opciju "purge" alata dpkg
#dpkg -P inkscape

Isti efekat se može posti i i pomo i alata apt-get, pri� �
emu e na isti na in biti uklonjeni i paketi koji zavi� � � -

se od programa koji se uklanja, komandom
#apt-get remove inkscape --purge

Još jedan od razloga zbog kojeg je  bolje koristiti

apt-get je otklanjanje problema. Naj eš e teško e se� � �
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javljaju usled lošh medija sa kojih se instaliraju pake-
ti ili loših pgp potpisa samih paketa. Apt-get e na� -
j eš e  javiti  grešku  i  upitati  korisnika  da  li  treba� �
instalirati ne-autorizovane pakete ukoliko se radi o

lošim potpisima. Ukoliko je paket koji se instalira i z
bilo kod razloga napravio problem, može do i do�
pojave nemogu nosti instalacije ostalih paketa. Ova� -
kav problem se rešava komandom
#apt-get -f install

prilikom ega e loši paketi biti uklonjeni a problem� �
rešen. Ovo je vrlo bitno upamtiti jer može do i do si� -
tuacije da  je problem mogu e rešiti  jedino na ovaj�
na in, bilo da se koristi neki konzolni ili grafi ki al at� �
za instalaciju.

Pored pomenutih, apt alati imaju puno opcija i mo-
gu nosti koje nude potpunu kontrolu nad sistemom�
paketa. Pomenu emo još jednu, koja ve ini korisnika� �
može zatrebati, a ti e se nadogradnje sistema. Apt-�
get  poseduje  opcije  upgrade  i  dist-upgrade  koje

omogu avaju instalaciju novih paketa i nadogradnju�
sistema bez potrebe za ponovnom instalacijom. Pre
nadogradnje je potrebno dodati izvore sa novim pa-
ketima, bilo da se paketi preuzimaju sa interneta ili

se instalacija vrši sa opti kih medija distribucije koj a�
se koristi i obaviti osvežavanje apt baze komandom
#apt-get update

Sam upgrade sistema se vrši komandama
#apt-get upgrade ili

#apt-get dist-upgrade

Opcijom  upgrade  se  instaliraju  nove  verzije  ve�
postoje ih programa, dok e se koriš enjem opcije� � �
dist-upgrade  "inteligentno"  ustanoviti  nove  zavi-
snosti koje su uzrokovane novim verzijama paketa.

Pored zavisnosti, koriš enjem ove opcije e se instali� � -

rati  paketi  sa  ve im  prioritetom,  o  emu  opcija� �
upgrade ne vodi ra una. Opciju dist-upgrade treba�
koristiti prilikom prelaska na novu verziju sistema.
Na ovaj na in je mogu e obaviti prelazak sistema na� �

novu verziju  veoma bezbolno,  gotovo bez  ikakvih
problema. Postoje sistemi na kojima je pre nekoliko
godina instaliran Debian Potato preveden u Sarge,
zahvaljuju i  odli no  rešenom sistemu za  nadogra� � -
dnju.

Grafi ki APT alati�
Iako je terminal neizbežan, mnoge distribucije se

trude da izbegnu kontakt korisnika, koji su navikli
na  potpuno grafi ko  okruženje,  i  crnog ekrana sa�

vrište im zelenim slovima. Razli iti aspekti posma� � -
tranja ovog problema nas dovode do opravdanja ili
negiranja pravilnosti ovakvog pristupa. injenica da�
GNU/Linux  sistemi  današnjice  pružaju  potpuno
komforna grafi ka  rešenja  kojima se  može  pokriti�

ve ina potreba "obi nih" korisnika je veoma važna.� �
Takav slu aj  je i  sa koriš enjem alata baziranih na� �
APTu, za koje postoje programi koji interpetiraju nji-
hov rad u grafi kom okruženju. Daleko najpoznatiji i�

najpouzdaniji program ovakve vrste je Synaptic.
Ve ina  poznatijih distribucija  koja je  bazirana na�

paketima u Debianovom formatu se isporu uje sa�
ovim alatom. Igrom slu aja, Synaptic je baziran na�
GTK bibliotekama i zahvaljuju i pojavi da distribuci� -

je  bazirane na KDE-u eš e uklju uju aplikacije  iz� � �
"suprotnog" tabora od sistema zasnovanih na GNO-
ME-u, Synaptic  postoji skoro na svakoj distribuciji.
Velika zastupljenost ovog programa nije slu ajna.�

Sve opisane operacije u tekstu je mogu e obaviti i�

pomo u Synaptica. Naravno, Synaptic je baziran na�
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aptu, stoga njime nije mogu e instalirati pojedina ne� �
deb  pakete.  Dodavanje  izvora  paketa,  instalacija  i
deinstalacija istih su poslovi koje Synaptic izvršava
bez greške. Pri tom, sve što treba uraditi je nekoliko

klikova.
Prozor menadžera paketa Synaptic je podeljen na

tri dela. Sa leve strane se nalaze oblasti odabira pa-
keta koje je mogu e menjati klikom na odre eni ta� � -
ster u dnu ovog polja, dok je desni deo podeljen na

dva dela, pri emu gornji sadrži spisak paketa, a do� -
nji širi opis paketa. Na listi paketa je mogu e videti�
da li je isti instaliran ili ne, koja verzija je dost upna i
kra e  obaveštenje  o  paketu.  Instalacija  se  obavlja�
obeležavanjem samog paketa klikom na ku icu po� -

red paketa i odabirom opcije 'Mark for installation'.
Da bi se selektovani paketi instalirali potrebno je pri -
tisnuti dugme Apply i apt-get e obaviti svoj posao.�
Deinstalacija paketa se obavlja na isti na in, prilikom�
ega je mogu e odabrati opciju 'Mark for Removal'� �

za uobi ajeno uklanjanje, i 'Mark for Complete Re� -
moval'  za  potpuno uklanjanje  paketa,  kao pri  ko-
riš enju komade�
#dpkg -P

Ovom prilikom je mogu e obaviti i reinstalaciju pa� -

keta upotrebom opcije 'Mark for Reinstallation'. Ak-
cije se izvršavaju pritiskom na dugme Apply.

Dodavanje novih izvora paketa se obavlja unoše-
njem adresa repozitorijuma u konfiguracionim dija-
lozima za  ovu namenu,  koji  se  dobijaju odabirom
opcije  Settings->Repositories,  dok  je  za  dodavanje

novog  opti kog  medija  potrebno  odabrati  opciju�
Edit->Add CD-ROM. Nadogradnju sistema je mogu-
e obaviti  veoma elegantno klikom na opciju Edit-�

>Mark All Upgrades, nakon ega se dobija dijalog u�
kom je potrebno izabrati metod nadogradnje. Kori-

snik može izabrati 'Default' ili 'Smart Upgrade', što je
ekvivalentno  ve  pomenutim  opcijama  upgrade  i�
dist-upgrade kod alata apt-get.

Synapticom je  mogu e reinstalirati  ili  popravljati�
loše instalirane pakete,  pretraživati  bazu  pa  ak  i�

instalirati  pakete  po tematskim grupama (Dektop,
Database, Web Server, Print Server, DNS Server...).
Bitno je da Synaptic sav posao obavlja besprekorno i
da za kvalitetnu manipulaciju paketima terminal uo-
pšte nije potreban.

Synaptic je daleko najbolji alat ove vrste. Ostali ala-
ti koji se mogu na i na sceni su siromašniji opcijama.�
Treba pomenuti Kpackage i Kynaptic, koji je relativ-
no nov alat na ovom polju i isporu uje se uz distri� -
buciju  Kubuntu.  Interfejs  pomenutih  programa  je

prijateljski nastrojen prema korisnicima, ali  je,  kao
što je ve  pomenuto, Synaptic daleko na vrhu kada�
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su funkcionalnost i lako a koriš enja u pitanju. i� � � -
njenica da je Synaptic u ve ini slu ajeva dostupan i� �

na distribucijama zasnovanim na KDE-u name e ga�
kao logi no rešenje za sve korisnike koji ne žele da�
koriste terminal.

Biblioteka APT i alati bazirani na njoj predstavljaju

jedan od najsavršenijih sistema za manipulaciju pa-
ketima na planeti. Pouzdanost, brzina, lako a i kraj� -
nji rezultati su pokazatelji koji APT name u kao veo� -
ma  logi an  izbor.  Prisutnost  odli no  rešenih  gra� � -

fi kih  interpretatora  alata  baziranih  na  aptu  zao� -
kružuje celu pri u, približavaju i manipulaciju pro� � -
gramima i neiskusnim korisnicima koji tako e treba�
da dobiju šansu da lako i brzo urade ono što žele na
svom sistemu.

Opisane mogu nosti  u ovom tekstu predstavljaju�
mali deo onoga što apt alati mogu. Pomenute opcije

predstavljaju ve inu onoga što prose nom korisniku� �
može zatrebati, pa su zbog toga i pomenute u tekstu.
Ukoliko vas zanima šta apt alati mogu, google i man
strane su vaši prijatelji. Prijatan apt-get!

Korisne adrese:
http://www.apt-get.org
http://www.nongnu.org/synaptic/
http://lnix.net/~froud/kynaptic/C/

~Ivan Jeli�
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IAKO  U GNU  OPERATIVNIM  SISTEMIMA ,  KAO  I U

NESLOBODNIM  SISTEMIMA  POSTOJE RAZNE  APLIKACIJE

SPECIJALIZOVANE  ZA  PRAVLJENJE OMOTA  ZA  VAŠE DISKOVE,
GIMP  JE GOTOVO SAVRŠEN ALAT  KOJ SLUŽI OVOJ SVRSI.
NE ETE�  MORATI  DA  U ITE�  KAKO  SE DRUGI PROGRAMI

KORISTE,  A JEDNOM NAPRAVLJEN  ŠABLON ETE�  UVEK MO I�

DA  ISKORISTITE. POKAZA EMO�  VAM  JEDNOSTAVNE PRIMERE

NA  NAJOBI NIJIM�  DISKOVIMA  OD 12X12CM I "SLIM"
KUTIJAMA ,  ALI  JE POSTUPAK SLI AN�  I KOD PRAVLJENJA

OMOTA  ZA  MANJE  DISKOVE.

Omot za slim kutiju

Veli ina slike za tanke Slim kutije je 120x120mm,�
pa treba otvoriti i nov papir ove veli ine. U Advan� -

ced Options možda ete želeti da stavite X,Y resolu� -
tion 300x300 pixel/in ili više pošto štampa i naj eš e� � �
koriste rezoluciju od 300dpi, 600dpi... Ako vam je la-
kše  imate  ponu en  i  templejt  (Template)  veli ine� �

obi nog CD-a prilikom otvaranja novog papira. Prvi�
sloj (Layer) tog papira treba da predstavlja sliku koju
uzimamo kao pozadinu, naziva se Backgorund i na-
lazi se ispod svih ostalih slojeva. Na ite, dakle, želje� -
nu sliku i dodajte je u ovaj sloj kao što smo to u inil i�

u  gornjem  tekstu.  Naravno,  omot  obi no  sadrži�
tekst. Kao što je u prethodnom broju GNUzille opi-
sano, možete dodavati tekst sa raznim efektima ili je-
dnostavna jednobojna slova, a jedino na vama je iz-

bor. Na kraju treba dodati jednu tanku crnu liniju po
ivicama naše slike kako bismo znali gde da ise emo�
budu i omot. Najlakše je koristiti Script-Fu > Decor�

> Add Border skriptu. Odaberite vrednost 1 za Bo-
rder X i Border Y Size (veli ina ivice horizontalno i�
vertikalno) i crnu kao Border color (boja ivice) kako
bi se lakše videla.  Stavite da vam novonastali  sloj
bude na samom vrhu (iznad ostalih). Možda ne ete�

videti ivicu, ali ona postoji, samo je isuviše tanka, i
nalazi se ispod linije koja obeležava granicu sloja. Ne
brinite,  vide e  se  prilikom  štampe.  Jednom  na� -
pravljeni  šablon  možete  snimiti  kao  Gimpov XCF
fajl, i kasnije koristiti uz zamenu slike i teksta on im

što Vama treba.

Kružna nalepnica za CD

Postoji nekoliko na ina da se napravi kružni omot�

za CD, ali  emo ovde izneti najjednostavniji. Kao i�
kod slim kutije potrebno, je uzeti papir 120x120mm,
možda nešto manji kako bi se lepše uklopio. Odmah
napravite novi sloj (Layer), i isklju ite vidljivost po� -
zadine (sloja Background). Selektujte celu površinu

preko Select > All i skupite selekciju za oko 5-10 pi-
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ksela sa Select  > Shrink kako biste dobili  pravilan
krug.  Odaberite  još  Select  >  Rounded  Rectangle,

podesite vrednost na 100, i dobili ste krug željene ve-
li ine. Potrebno je podebljati liniju preko Edit > S tro� -
ke Selection, odabirom vrednosti 1 za Line Width.
Po ovoj liniji emo docnije ise i omot. Sloj Backgro� � -
und e biti slika za omot. On treba da se nalazi ispod�

ostalih, a upravo napravljeni sloj treba da prekriva
prostor van podebljane linije. Odaberite Select > In-
vert, uzmite belu boju i kanticu (Bucket Fill), pa k li-
knite na prostor van linije (naravno u novom sloju,

ne Backgroundu). Sada treba da napravimo i mali
kružni izrez po sredini omota za otvor na disku. Po-
novo odaberite Select > Invert kako biste vratili sli ku
u prethodno stanje. Sada treba da skupimo selekciju

sa  Select  >  Shrink.  Kako  je  polupre nik  omota�
60mm, potrebno ga je skupiti za 52mm da bi u sre-

dini ostala kružnica pre nika 16mm, koliki je i otvor�
na disku. I sada odaberite Edit > Stroke Selection da
biste podebljali liniju na mestu gde ete je se i, i be� � -
lom bojom ofarbajte prostor unutar te linije. Ukoliko
želite da ozna ite i centar, samo skupite liniju za još�

7mm i ofarbajte prostor unutar selekcije u crno. Na-
ravno postavite sada i sliku u pozadini, dodajte tekst
koji vam se svidi i napravili  ste omot. Pazite samo
kod se enja omota - mora biti perfektno ise en kako� �

ne bi narušio ravnotežu diska i pokvario vam CD i� -
ta .�

~ Miloš Popovi�
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U  TEKSTU KOJI SLEDI NAU I EMO� �  ŠTA SU SLOJEVI,  EMU�

SLUŽE, KAKO  SE ONI  KREIRAJU I URE UJU� . SLOJEVI SU TU DA

NAM  OLAKŠAJU RAD SA GRAFIKOM . BEZ NJIH BILO KAKVA

SITNA  INTERVENCIJA  NA  SLICI BILA  BI MUKOTRPNA  I TEŠKA,
A  NAJPROSTIJE SLIKE BI VAS KOŠTALE NEKOLIKO  DANA

PROVEDENIH  ZA  RA UNAROM� .  POMO U�  SLOJEVA MO I�

ETE�  BILO KOJI DEO SLIKE DA  IZMENITE  TAKO  DA  NE

UTI ETE�  NA  SLIKU KAO  CELINU .

Šta su slojevi
Kada govorimo o slojevima možete ih zamisliti kao

providne listove papira koji  se re aju  jedan preko�
drugog. Ukoliko je na svakom od tih listova nešto is-
crtano, krajnji rezultat bi e suma svih crteža na pro� -
vidnim papirima - pogledajte sliku:

 Imamo etiri sloja prikazana u Gimpovom prozo� -

ru Layers, Channels & Paths, i izgled kona ne slike�
koju ti slojevi sa injavaju. Prvi sloj na vrhu (Vilber )�
se nalazi iznad svih ostalih slojeva. Poslednji sloj je

bela pozadina sa plavim krugom i on se nalazi na

dnu što zna i da ga bilo koj drugi sloj prekriva.�

Prozor Layers, Channels & Paths
Od verzije  2.X ovaj dijalog je smešten u desnom

prozoru Gimpa, a sama kartica Layers je prva i od-

mah je  uklju ena po  pokretanju  programa (gornja�
slika). Sada emo da objasnimo njene osnovne opci� -
je. Prva opcija, Mode, odre uje na in na koji e pi� � � -
kseli layera u pozadini biti preklapani sa pikselima
layera ispred. Blending Modovi e biti objašnjeni u�

nekom od narednih brojeva. Sa desne strane je Keep
Transparency check-box. Slede a opcija je Opacity.�
Opacity odre uje stepen transparencije (providnosti)�
slojeva. Naredna opcija koja se nalazi u samom dnu
prozora jesu dugmad. Više o njima pro itajte dalje u�

tekstu. Glavna stvar dijaloga Layers je takozvana pa-
leta slojeva (Layera). To je deo gde je prikazan uma-
njeni izgled (preview) slojeva, i neke osnovne opera-
cije nad njima. Naša slika ima etiri sloja. Svaki od�
slojeva u paleti slojeva ima sa leve strane ikonicu u

obliku  oka.  Ukoliko  je  ona  uklju ena  sloj  e  biti� �
vidljiv  u prozoru Image (prozoru u kojem je slika
otvorena),  odnosno  biti  sa uvan  tokom  narednog�
snimanja slike. Slede a je ikonica lan i a koja simbo� � � -

lizuje link. Kada uklju ite ovu ikonicu na dva ili viš e�
Layera  oni  e  biti  pomerani  zajedno dok koristite�
alat Move.         Mala slika u paleti slojeva predsta-
vlja umanjeni prikaz (preview) sloja, a desno od nje
je ime sloja. Ime sloja najlakše menjate dvoklikom na

njega. Prime ujete da je sloj pod nazivom Backgro� -
und uokviren plavo. Ovaj  sloj je takozvani aktivni
sloj. Bilo šta da radite u prozoru Image bi e ura eno� �
samo na aktivnom sloju. Na taj  na in radite na je� -
dnom sloju a druge ostavljate netaknutim. To je kao

da ste izvukli  jedan od providnih papira o kojima
smo pri ali malo as i docrtali nešto na njega, a onda� �
ga  vratili  u  celokupnu  sliku.  Umesto  da  vadite  i
vra ate papire, ovde možete menjati aktivne slojeve�
tako što jednom kliknete na njih. Ispod palete slojeva

nalaze se par korisne dugmadi. Prvo dugme s leva
kreira novi sloj, slede e podiže aktivni sloj za jedno�
mesto naviše u paleti, a slede e radi suprotno. Tu je�
zatim dugme koje pravi duplikat aktivnog sloja, du-
gme koje "usidrava plivaju i sloj" i dugme koje briše�

aktivni sloj. Treba još znati da se desnim klikom na
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sloj dobija meni. Najvažnije opcije se nalaze na po-
menutoj dugmadi dijaloga Layers, a par njih je ob-

jašnjeno dalje u tekstu.

Plivaju i sloj (Float selection) i usidrava� -
nje (Anchor)

Plivaju i  sloj se javlja prilikom nekih operacija u�

Gimpu. Kada on postoji ujedno je i jedini mogu i ak� -
tivni sloj  na  slici,  dok je rad  na ostalim slojevima
onemogu en.  Ipak,  bilo  koja  operacija  se  može�
preduzeti na ovom sloju. Kada napravite neku selek-

ciju -  obeležite  deo slike (pogledajte letnji  dvobroj
GNUZille) i pomerite ga na drugo mesto, on e auto� -
matski postati novi plivaju i sloj. Tako e, kada želite� �
da neki sloj kopirate iz jednog u drugi prozor Image
(primer dat u tekstu ispod) pojavi e se plivaju i sloj.� �

Ukoliko  sami  želite  da  napravite  plivaju i  sloj  to�
možete u initi tako što prvo obeležite neki deo slike i�
odaberete Select > Float iz Image prozora - obeleženi
deo je postao novi plivaju i sloj.�

Kada napravite plivaju i sloj mora ete da ga se ne� � -

kako otarasite  da  biste mogli  da  radite sa  ostalim
slojevima.  Ovaj  postupak  se  naziva  Anchor  (Usi-
dravanje, nalepljivanje...), i cilj mu je da se plivaju i�
sloj pretvori u obi an. Prvi na in je da ga zalepite za� �
prethodno aktivan sloj. Možete to uraditi preko du-

gmadi koja se nalazi ispod palete slojeva u dijalogu
Layers, biraju i pretposlednje dugme sa leve strane�
u obliku sidra, pritiskanjem desnog tastera na pluta-
ju i sloj i odabirom Anchor Layer iz menija, ili Ctrl +�
H pre icom sa tastature. Drugi na in je da plivaju i� � �

sloj usidrite na novi sloj umesto na poslednji aktiv ni
sloj. To se radi preko prvog dugmeta sa leve strane
ili desnim tasterom na plivaju i sloj i odabirom opci� -
je New Layer. Ova varijanta je bolja, što ete i sami�

uvideti kada nau ite nešto više o primeni slojeva.�

Jednostavan primer koriš enja (n)ovog znanja�
Pokuša emo da dodamo neki sloj (Layer) jedne sli� -

ke u drugu. Morate da otvorite sliku sa koje emo da�

kopiramo sloj (kod nas je to bila slika Vilbera) i jedan
prazan papir na koj emo da ga dodamo. Kopiranje�

sloja vrši se tako što se sloj koji kopiramo u ini aktiv� -
nim i odabere se opcija Copy (Edit > Copy ili Ctrl +
C). Sada treba da pre ete u prozor Image slike na�
koju želite da prenesete ovaj sloj, i odaberete Paste
(Edit > Paste ili Ctrl + V). Preneti sloj e se pojaviti�

kao Floating Selection (plivaju i sloj).  Plivaju i sloj� �
možemo pomeriti tamo gde želimo alatom Move,  i
zatim ga „usidriti“ kao što je ve  objašnjeno.�

Prime ujete  kockastu  crno-žutu  liniju  u  prozoru�

Image oko novog sloja. Ova linija ograni ava svaki�
sloj, ali mi to obi no ne vidimo jer su slojevi uglav� -
nom iste veli ine kao i prozor Image. Ukoliko vam�
ova ivica nekada zasmeta, možete je isklju iti iz me� -
nija prozora Image View > Show Layer Boundary.

Tako e, ivice sloja možete uve ati na veli inu prozo� � � -
ra Image. Kliknite desni taster na sloj koji želite da
pove ate, pa odaberite Layer to Image Size. Sli no� �
možete i sami pove ati ivice sloja na željenu veli inu� �
preko Layer to Boundary Size (odaberete vrednost i

kliknete Resize dugme), ili pove ati ceo sloj (ne samo�
ivice) sa Scale Layer.

Pomeranje slojeva
Za pomeranje slojeva je potrebno da sloj koji pome-

rate bude aktivan. Osnovno pomeranje vrši se ala-
tom Move, što je ve  re eno. Potrebno je da uzmete� �
alat Move, kliknete i  držite levi taster na neki deo
aktivnog sloja (koji  mora biti  transparentan od 0%
do 50%) dok pomerate sloj na željeno mesto. Kada

ste ga namestili, samo pustite levi taster i izvršili ste
pomeranje. Kao što je ve  re eno, ukoliko više sloje� � -
va  želite  da  pomerite  odjednom,  možete  uklju iti�
ikonicu  u  obliku  lan i a  (link)  u  paleti  slojeva.� �

Možda ete sada poželeti da veli inu sloja prilagodi� � -
te veli ini same slike (prozora Image) na na in koji je� �
ve  opisan.�

Ponekada se pomeranje ne može izvršiti precizno
ukoliko ne koristimo neke grani nike. Osnovni gra� -

ni nici  su  grani ne  linije  (Guides),  ali  se  i  mreža� �
(Grid) može koristiti u istu svrhu. Da bi ovi grani ni� -
ci bili vidljivi, morate imati ozna enu opciju View >�
Show Grid i View > Show Guides. Sada, iako vidlji-
vi, oni još uvek ne služe svojoj svrsi. Da bi se pome-

reni sloj „zalepio“ za grani ne linije ili mrežu, opcije�
View > Snap to Grid i View > Snap to Guides moraju
biti uklju ene. Mreža vam obi no služi kao orjentir� �
prilikom  rada  sa  slikom.  Prored  i  izgled  mreže
podešava se u opcijama (Preferences) Gimpa ili za-

Oktobar 2005 / GNUzilla  / 33



Radionica

sebno, preko menija Image > Configure Grid. Gra-
ni ne linije postavljete sami na mesto koje želite. Oni�

se  nalaze u  lenjirima prozora  Image(leva  i  gornja
strana Image prozora) i izvla e se tako što kliknete�
na lenjir i držite levi taster, prevu ete grani nu liniju� �
tamo gde želite da je ostavite i  pustite  levi  taster.
Možete postaviti onoliko grani nih linija koliko Vam�

je  potrebno.  Liniju  uklanjate  tako  što  je  ponovo
prevu ete sa prozora Image na lenjir. Grani ne linije� �
možete  postaviti  i  preko  menija  Image  >  Guides.
Prva opcija New Guide (By Percent) postavlja gra-

ni nu liniju uzimaju i procentualne vrednosti veli i� � � -
ne slike. U dijalogu je dovoljno odabrati da smer (Di-
rection)  bude vertikalan ili  horizontalan i  meru u
procentima, tako da e npr. 50% postaviti liniju po�
sredini slike. Opcija New Guide iz menija radi isto

što i prethodna, ali vrednosti nisu date u procentima
ve  u pikselima. Opcija New Guides From Selection�
postavlja grani ne linije na ivicama obeleženog dela�
(selekcije).  Opcija  Remove All  Guides  uklanja  sve
grani ne linije sa slike. Da biste videli kakav je efekat�

pomeranja  sloja  sa  uklju enim  opcijama  Snap  to�
Grid i Snap to Guides, mora ete da ih sami isproba� -
te. Prilikom pomeranja nekog sloja, njegove ivice e�
se zalepiti  za  grani nu liniju ili mrežu.  Ovo je,  na�
primer, korisno kada želite da vam tekst bude napi-

san jedan ispod drugog.
Takozvana transformacija slojeva može se uraditi

sa  nekoliko  Toolbox  alata.  Tu su  alat  za  rotiranje

(Rotate),  alat  za širenje (Scale),  alat  za  iskošavanje
(Shear), alat za menjanje perspektive (Pesrpective) i

alat za preslikavanje (Flip).

Spajanje slojeva
Spajanje slojeva radimo na kraju obrade slike kako

bismo je mogli snimiti u nekom od formata koji ne

podržava slojeve.  Spajanje se vrši na nekoliko na i� -
na. Prvi na in je spajenje aktivnog sloja sa onim is� -
pod njega. To se radi odabirom opcije Merge Down
iz menija koji se dobija desnim tasterom na aktivni

sloj. Drugi na in je spajanje svih slojeva odjednom�
odabirom Image > Merge Visible Layers iz prozora
Image ili pre icom Ctrl + M sa tastature. Tre i na in� � �
Image > Flatten Image, pored toga što spaja sve slo-
jeve, vrši i popunjavanje transparentnih delova po-

zadinskom bojom, tj. uklanja Alfa kanal boja. Manje
važno je što on primenjuje Maske na svim kanalima.
Ukoliko ne snimite sliku u Gimpov XCF format, iz-
gubi ete podatke o slojevima jer e oni biti spojeni.� �
Ukoliko na primer snimite u JPEG, ne samo da ete�

izgubiti  podatke o slojevima ve  e i  transparentni� �
delovi biti  uništeni (Flatten).  Zna i sliku obavezno�
snimite i u XCF format da biste je kasnije mogli do-
ra ivati.�

~ Miloš Popovi�
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UBRZAN  RAZVOJ INTERNETA  I IT-A  JE, KAKO  SE TO MOGLO

I O EKIVATI� , IMAO  I SVOJE NUS-PRODUKTE. OVOM  PRILIKOM

EMO�  ZAOBI I�  PROBLEMATIKU  TROJANACA , CRVA I OSTALOG

MALICIOZNOG  KODA . ZAOBI I EMO� �  I SVE ONE "HO U�  DA

BUDEM  HAKER " KLINCE  KOJI BUKVALNO  OPSEDAJU MREŽU.
JEDAN  OD ZASTRAŠUJU IH�  I, SVAKAKO , VEOMA  IRITIRAJU IH�

PROBLEMA KAKO  KORISNIKA  TAKO  I ADMINISTRATORA

SERVERA JE SPAM TJ. NEŽELJENA POŠTA.

Šta je uopšte spam?
Skoro me je  neko pitao  šta  se sve podrazumeva

pod spamom i moram da priznam da nisam umeo
da  dam  potpuno  precizan  odgovor  na,  naizgled,

prosto pitanje. Neželjena pošta može biti veoma re-
lativan pojam jer ono što za mene jeste neželjeno za
nekog tre eg ne mora biti. A opet, u svetu neželjene�
pošte ipak postoji šablon kako izgleda klasi na poru� -
ka. Verujem da se svakom ko ita ovaj tekst desilo�

neznano puta da dobije email poruke sa informaci-
jom kako je primalac iste dobio milion dolara, kako
može prate i odre eni link iz poruke da dobije po� � -
tpuno nov iPod i ko zna šta još. Možda vam ovakve
poruke samo idu na nerve. Možda ih ak ni ne vidite�

jer  ste  lepo  podesili  svoj  program  za  elektronsku
poštu, te on sve to lepo filtrira. A možda je vaš pro-
vajder toliko revnosan, pa je lepo podesio server te
se neželjena pošta filtrira na samom ulazu.

Ma  koliko  vam  izgledalo  bezazleno  to  što  vam

neko šalje  tu  vrstu  poruka,  one ipak predstavljaju
veliko  optere enje  za  Internet  infrastrukturu,  te  u�
mnogome otežavaju saobra aj. I što je najgore, neko�
tamo biva pla an da distribuira sav taj spam. Ne mi� -
slite valjda da se te poruke šalju same od sebe?

Kao što sam ve  rekao, no na mora svakog admini� � -
stratora nisu toliko virusi i "hakerski" napadi koliko
neželjena pošta. Krajnji korisnik je zadovoljan kada
mu sa servera ne stiže neželjena pošta no nije ni sve-

stan koliko resursa može da oduzme filtriranje iste.
Server mora da proveri poštu koja pristiže, pa ako se
radi o spamu on e ga ukloniti. I tako u �  nedogled.
Spamer e nastaviti svoju aktivnost, server e trpeti� �
optere enje  a administratora e  boleti  glava.  U ta� � -

kvim  trenucima  pomenuti  administrator  može  da
dobije  kojekakve sumanute  ideje,  gde bi  jedna od
njih svakako bila osveta onome ko se bavi distribui-

ranjem neželjene pošte. Taj neko biva pla an za svu�
dostavljenu poštu, a sve to ispaštaju krajnji korisnici
Interneta. Zar ne bi bilo sjajno kada bi, bez nekih na-
prednih programa i znanja, mogli da vratimo milo

za drago kriminalcu jer spamer to i jeste. O da, to bi
bilo zaista divno.

Vaš verni prijatelj BSD
Prosto je fasciniraju e šta se sve može posti i  uz� �

pomo  par eta  kanapa,  tri  šibice  i  kante napalma.� �
Verovatno mnogo toga ukoliko vam se spamer na-
lazi pri  ruci. Me utim, ukoliko je to neko NN lice�
koje se nalazi tamo negde, doti ne alatke vam ne e� �
biti  od koristi.  Možda je  bolje da  upotrebite  malo

svoju  maštu  i  svoj  BSD sistem,  i  napravite  sjajan
posao, mada šibice i napalm zaista zvu e sjajno kada�
ste iznervirani.

Za akciju koju emo sprovesti e vam biti potrebne� �

alatke koje svi korisnici BSD sistema imaju na svojim
mašinama. Krenimo redom.

Lažni SMTP serveri
Svim korisnicima UNIX-a i sistema sli nih UNIX-u�

je poznata aplikacija spamd. U pitanju je lažni SMTP
server koji zapravo ne prenosi poštu ve  drži otvore� -
nu vezu prema klijentu i odgovara jako sporo. Ako
je  klijent dovoljno strpljiv da  završi SMTP dijalog,
koji može potrajati 10 i više minuta, lažni server e�

mu poslati obaveštenje o privremenoj grešci i obave-
stiti ga da pokuša kasnije. Ukoliko se pokušaj ponovi
procedura se, naravno, ponavlja. Posle nekoliko po-
kušaja spamer e uzalud trošiti svoje resurse i kona� -
no odustati. Ovo nam oduzima ziasta malo resursa,�

te je jako dobro rešenje.

Crne liste
Crne liste proskribovanih ljudi su bile popularne u

vladaju im krugovima raznih država u razli itimm� �

epohama. Ukoliko vam se neko ne dopadne, a vi ste
na višoj lestvici u hijerarhiji podele vlasti, stavite  ga
lepo na crnu listu i završite s tim. Mislim da ne treb a
ni da napominjem kako je i sama ideja poprili no za� -

strašuju a i neprijatna, ali zar nije itava istorija o� � � -
ve anstva bila prepuna nebuloznih ideja ludaka koje�
su bile sve sem lepe i prijatne.
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Pošto sam održao kra i monolog na temu ljudskih�
prava krozi istoriju oduzimanja istih, valjalo bi da se

vratim  na  našu  glavnu  temu.  Crne  liste  u  svetu
Interneta predstavljaju baze podataka provajdera i
korisnika koji  su poznati  po lošem ponašanju,  pre
svega slanju neželjene pošte, te je istima ograni en�
saobra aj, usluge ili nešto tre e. Crne liste za spame� � -

re su jako fine samo što u  ve ini slu ajeva ne za� � -
dovoljavaju naše potrebe. Obi no je potrebno dosta�
vremena dok se novi hostovi dodaju na liste, ili su
pak liste previše agresivne za naš ukus. Neke liste

uklju uju  pojedina ne  hostove  dok  neke  sadrže� �
kompletne mreže ime prisiljavaju Internet  provaj� -
dere da reaguju i u lokalnoj mreži suzbiju spamere.
Ovo može da bude nezgodno, jer tako zbog pojedin-
ca stradaju nedužni korisnici. No, ako i pretpostavi-

mo da ste vi diktatorski raspoložen manijak koji e�
izabrati najagresivniju crnu listu koja postoji apsolu-
tno zanemarivši  99% korisnika koji  sa  tim nemaju
veze, ipak ostaje dosta prostora da vam se neželjena
pošta ipak provla i.�

Ako ste,  pak,  razuman ovek i  smatrate  da  se o�
svom serveru ipak vi možete najbolje starati, onda
ete kao opciju izabrati da sami pravite crne liste te�

da sami odre ujete šta i kako se tu dešava. Pretpo� -
stavimo da vam je podešavanje procmaila slede e:�

:0fw

| /usr/local/bin/spamc

:0:

* ^X-Spam-Status: Yes

in-x-spam

Sva  dolaze a  pošta  e  biti  propuštena  kroz  de� � -
tektor spama. Ukoliko spada u neželjnu poštu bi e�
preba ena u posebnu datoteku. Ovo bismo mogli da�
obrišemo, ali je daleko bolje da umesto toga proveri-

mo dolaze e poruke za pogrešan spam. Kada se kla� -
sifikovanje jednom podesi kako treba skoro sva ne-
željena pošta e biti detektovana.�

Upotrebimo  sada  alatku  relaydb  da  napravimo
bazu  podataka neželjene pošte.  Ovo se radi  posle

klasifikacije pošte kako bismo u bazu podataka upi-
sali da li korisnik šalje regularnu poštu ili pak onu
neželjenu.

Dodajemo slede i red u konfiguraciju procmaila:�
:0fw

| /usr/local/bin/spamc

:0c

* ^X-Spam-Status: Yes

| /home/dhartmei/bin/relaydb -b

:0:

* ^X-Spam-Status: Yes

in-x-spam

:0c

| /home/dhartmei/bin/relaydb -w

Dakle, otkriveni spam prolazi kroz relaydb -b (crna
lista), a regularna kroz relaydb -w (bela lista). Ovde

valja primetiti da samo kopije poruka prolaze kroz
relaydb, program ih nikada ne modifikuje ili odba-
cuje. Sve što radi je da pravi listu hostova koji nam
šalju poruke razdvajaju i pri tom neželjnu poštu od�

regularne.
Kada se ova procedura ponavlja neko vreme re-

laydb e napraviti i crnu i belu listu. Nešto što ete  i� �
sami primetiti  jeste da su regularne poruke uglav-
nom ve e od  spama. Zbog toga relaydb pravi  iz� -

veštaj  samo kada je broja  neželjene pošte tri puta�
ve i nego broja  regularne.  Zbog toga server  ne e� � �
završiti na crnoj listi ukoliko šalje regularnu poštu.
Ali kada nam do e pošta sa servera koji nikada pre�
ništa nije slao bi e istog trena stavljen na crnu listu(1�

>= 0*3).

Šlag na tortu
Sada imamo svoju crnu listu pošiljalaca neželjene

pošte, klasifikovanih na na in na koji mi to želimo i�

po našim kriterijumima. Nema razloga da verujemo
nekim  drugim  serverima  da  li  je  nešto  neželjena
pošta ili ne. Hajde da sada našeg kriminalca pošalje-
mo tamo gde mu je mesto. Upotrebi emo PF (Packet�
Filter) o kome sam pisao u ranijem broju i cron.

$ pfctl -sn

rdr inet proto tcp from <spammers> to any

port 25 -> 127.0.0.1 port 8025

$ relaydb -lb | pfctl -t spammers -T re-

place -f -

Ono što e se ovde dešavati zavisi samo od vaše�
mašte i volje da se igrate. Umesto da relaydb preu-
smerava na spamd možemo to iskombinovati sa spa-

mhaus. Ili možemo promeniti belu listu da ljudi sa
nje ne budu slati na spamd itd.

Ovo je skripta koju sam ja upotrebio za generisanje
crne liste za relaydb i eksterne RBL, a potom dodao
realydb belu listu.

#!/bin/sh

# assemble blacklist from relaydb, SBL and

CBL

relaydb -lb >~/spammers.tmp
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cat ~/rbl/sbl/SBL.cidr | grep -v '#' | cut

-f 1 >>~/spammers.tmp

cat ~/rbl/cbl/list.txt | grep -v '#' | grep

-v '^:' >>~/spammers.tmp

pfctl -t spammers -Tr -f ~/spammers.tmp

# use relaydb whitelist to remove/negate

entries

relaydb -lw | \

       pfctl -t spammers -vvTt -f - | \

       grep "^M " | grep -v "/" | \

       awk '{ printf("%s\n", $2); }' | \

       pfctl -t spammers -Td -f -

relaydb -lw | \

       awk '{ printf("!%s\n", $1); }' | \

       pfctl -t spammers -Ta -f -

Na ovaj na in e desetine, pa i stotine konekcija biti� �
preusmereno u našu zamku, i ve ina pošiljalaca ne� -
željene pošte e trošiti desetine minuta po konekciji,�
nekoliko  pokušaja  i  tako nekoliko dana.  Uticaj  na
naše resurse je minimalan. Evo primera:

Sep 21 22:22:29 spamd: 216.27.68.125: con-

nected (9)

Sep 21 22:38:08 spamd: 216.27.68.125:

<s.robertson@laposte.net> -> <pf@ben-

zedrine.cx>

Sep 21 22:52:12 spamd: 216.27.68.125: Sub-

ject: =?iso-8859-

1?Q?CONGRATULATIONS!!!_YOU_HAVE_WON_THE_LOT

TE

Sep 21 22:54:57 spamd: 216.27.68.125: From:

"=?iso-8859-1?Q?s.robertson@laposte.net?="

<s.robertson

Sep 21 22:55:21 spamd: 216.27.68.125: To:

"=?iso-8859-1?Q?s.robertson?=" <s.robert-

son@laposte.net>

Sep 21 22:56:52 spamd: 216.27.68.125: Body:

--

_=_XaM3_Bdry.1061517084.2A.222095.42.21084.

52.42.1010.609

Sep 21 22:57:44 spamd: 216.27.68.125: Body:

Content-Type: text/plain; charset=iso-8859-

1

Sep 21 22:58:25 spamd: 216.27.68.125: Body:

Content-Transfer-Encoding: quoted-printable

Sep21 23:00:05 spamd: 216.27.68.125: Body:

=0D=0A   AGENCY (ACCREDITED LICENSED AGENT

TO GLOBAL LOTTER

Sep 21 23:03:16 spamd: 216.27.68.125: Body:

L).=0D=0A =0D=0A=0D=0A=0D=0AReference Num-

ber:9002178/347=0D

Sep 21 23:04:45 spamd: 216.27.68.125: Body:

rs:214/879/551/CM44.=0D=0ASir/Madam,

=0D=0AWe are pleased

Sep 21 23:06:56 spamd: 216.27.68.125: Body:

f the result of the Lottery Winners Inter-

national programs

Sep 21 23:09:43 spamd: 216.27.68.125: Body:

th August, 2005 that your e-mail address

attached to ticket

Sep 21 23:10:13 spamd: 216.27.68.125: dis-

connected after 2864 seconds.

Pošiljalac se zaglavio skoro sat vremena. Spamd je
podešen  da  prima  me umemoriju  veli ine  jednog� �
karaktera, primoravaju i pošiljaoca da šalje po jedan�
TCP paket za svaki bajt podataka, ak i ako je u pita� -

nju nestandardni "dump and disconnect" program.
Naravno, on e gotovo istog momenta pokušati da�
pošalje neželjenu poštu opet. I tako u nedogled.

Ova igra ma ke i  miša se može primeniti na sve�
BSD sisteme iako je primarno namenjena OpenBSD-

u. I jednom dobro podešena rešava jedan od glavnih
problema  na  serveru.  Upamtite,  kada  spamer  je-
dnom pro e on je kriv. Ali kada pro e i drugi put� �
krivica je vaša.

~Marko Milenovi�
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